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# Disclaimer and Safety
Lasers use intense beams of light to create heat and fire as a normal part of their operation, and
depending on the laser, the light might not be visible to you. When used safely, a laser cutter is
an incredibly useful tool. However if the proper safety measures are ignored, you could burn or
blind yourself or someone else, or start a fire that could damage or destroy your home, or in the
worst case, kill someone. CO2 lasers use high voltages, and if wired incorrectly could kill you.
Do not leave a running laser unattended.
By using this software, the user accepts complete responsibility for each and every aspect of
safety associated with the use of the laser machine, laser system and LightBurn Software.
You agree that:
You will not hold the author or contributors of LightBurn liable for any damage to equipment
or persons from the use of LightBurn.
You understand the potential hazards in using high power lasers and high voltages.
You will wear proper eye-protection rated for your laser when operating it.
You will use the LightBurn software in a legal and safe manner.
You relieve the author and contributors from any liability arising from the use or distribution
of the LightBurn software.
You are entirely operating at your own risk. Lasers can be lethally dangerous.

Setting up LightBurn for the first time
Downloading the software
Installing LightBurn
Running LightBurn for the first time
Skip Ahead: For more info on how to use LightBurn, check out the Software walk-through for
beginners

Adding Your Laser to LightBurn
LightBurn can’t control every laser, but it can talk to a number of different types of laser
controllers, all of which use different ways of communicating, and have different abilities and
settings.
This step tells LightBurn what you have.
If you’ve never configured a device in LightBurn, you’ll be brought here automatically when you
run the software. It is important that you pick something because the interface in LightBurn will
change depending on the capabilities of the laser you choose.
If you’ve done this before, but want to change your laser, or add a new one, click the ‘Devices’
button in the Laser Window to bring up the devices list.

DevicesButton
LightBurn can also be configured to control more than one laser, and there are settings stored for
each device. If you don’t pick one, we have nowhere to put these settings, and a number of
features within LightBurn will not work until this is set up.

T H E DEV IC ES PA G E

DevicesPage
This is the Devices page in LightBurn. Here you will see a list of all the laser devices you’ve added
to LightBurn, or an empty list when you’re first starting.
The simplest way to proceed is to click ‘Find My Laser’ and let LightBurn try to figure out what you
have. If that doesn’t work, your laser connects with Ethernet, or you have a Marlin device, you’ll
need to use ‘Create Manually’. If you’re using a LightBurn Bridge device, you can use the
LightBurn Bridge setup.
Find My Laser
Create Manually
LightBurn Bridge
You can also import export a laser configuration from another computer using the Export button
on this page from the source computer, and then import it to the new install using the Import
button. Export will create a .lbdev file containing all of the device specific information LightBurn
requires.

W H AT IF I DON ’ T H AV E A L A S ER YET?
We get asked this frequently - You don’t ever need to connect a laser to LightBurn to use it, but
LightBurn will not run without a device profile configured, because it needs a place to store some
settings, and wants to know what options to show you in the interface. If you use a laser that
accepts files on a USB drive, for example, LightBurn needs to know which controller it uses so it
can produce the correct output files.

If you don’t have a laser yet, or don’t know what you’re going to buy and just want to try it out,
you can just set up an arbitrary device profile, because these options don’t affect the design side
of things, just the machine output and laser settings.
In either case, use Create Manually and configure the things you can, and guess at whatever you
don’t know - it won’t matter in the end. When you finally do get your laser, you can come back to
this screen, select the ‘dummy’ profile you set up, and click ‘Remove’. Close the window, restart
LightBurn, and the software will guide you through the setup again, pulling many of the settings
from the controller of your machine. If you get it mostly right, you can double-click the existing
profile, then go through the pages and change anything you need to later. Either way works.

Configuring a laser for use with
LightBurn
If you have a DSP controller that came already installed in your laser, you shouldn’t need to do
anything to set your machine up for use with LightBurn, and can move on to the beginner
walkthrough.
If you have a GCode controller, particularly if you also use your system as a CNC or 3D printer,
there may be additional configuration required.
Common GRBL setups
Troubleshooting (to be completed)
If you have a Ruida DSP controller, and are configuring from scratch, read here:
Configuring a Ruida

LightBurn walk-through for beginners
If you’ve never used LightBurn before, the main window might seem a little intimidating. Try not
to let it scare you - we’ll break out the important sections to start with. LightBurn also has a
couple features to make it easier to learn:
Pop-up tips: If you hover the mouse over a control, you’ll see a small bit of text that describes that
button or feature, like this:

ToolTips-1
Context-help: If you hover the mouse over something and press the F1 key (help), LightBurn will
launch the help page for that feature in your browser. Most of the panels and buttons on the main
window of LightBurn will do this.

T H E MA IN WIN DOW
This is the default layout for the main LightBurn window:

MainWindow
Here it is again, with the sections labeled:

MainWindow
It’s worth noting that along the very bottom of the main display is a status bar that will
occasionally show information like an automatic backup in progress, position of the cursor, laser
connecting, and so on.
The main sections of the user interface are:
Menus
Main Toolbar
Creation & Modifier Tools
Color Palette
Cuts / Layers window
Size and Position / Numeric Edits
Font and Text properties
Laser control window
The workspace / Edit window
For a full list of the windows in LightBurn, see the LightBurn Windows topic in the help.
These are the windows you will use most commonly, though there are others. If you ever close
one accidentally and want it back, go to the menu, click the Window menu, or just right-click an
empty space on the toolbar, and re-enable the window you want back.

M EN U S
Almost all desktop software uses menus in some form. The menu bar at the top of the main
window gives you access to almost every feature available in LightBurn.

Menus
Depending on the operating system you’re using the menus might appear a little differently, and
some features may be removed if your laser doesn’t support them.
If a feature has a shortcut, it will be shown next to it in the menu, as shown above. Learning the
shortcuts for the features you use most often will make using LightBurn much faster, and
sometimes there are even ‘shorter’ shortcuts - you can find these in the help menu under Help >
Quick Help and Notes.
Menus in depth

M A IN TOOL B A R
The main toolbar in LightBurn gives you quick access to commonly used functions for opening or
importing files, saving, using the clipboard (copy & paste), moving or zooming the view. Right
beside it is the Arrangement toolbar, containing some commonly used arrangement tools for
arranging and aligning shapes.

MainToolBar
If you aren’t sure what a button is for, hover the mouse over it and it will tell you:

MainToolbar-Tooltip
Main Toolbar in depth (to be completed)
Arrangement Toolbar in depth

C R EATION & MODIFIER TOOL S
The shape creation tools are normally arranged vertically, but we’re showing them sideways here.
By default, these are docked along the left side of the work space for quick access.

CreationTools
The first tool, ‘Select’ is probably the one you’ll use most, and is the default tool chosen when
LightBurn starts. The others are used to create basic shapes like circles and rectangles, text, and
lines, and there are few for modifying shapes in more complicated ways, like merging shapes, or
creating lots of copies of shapes.
Creation Tools in depth
Modifier Tools in depth

C OLOR PA L ET TE
The color palette lives along the bottom of the main window by default, though a common
alternative is docking it next to the creation tools along the left.

ColorPalette
Lasers don’t “print” in color, so these colors are used to assign different kinds of operations to the
shapes in your design. A common convention is to use bright red for cuts, though how you use the
colors is up to you.
With nothing selected in the workspace, click a color entry and new shapes will be created in that
color. If you have something selected, clicking a color entry will apply that color to the shapes in
your selection. The colors currently in use in your design will also appear as entries in the Cuts /
Layers window, where you can choose the operations that each color represents.
Tool Layers
There are 2 special layers at the end of the cut palette, labeled T1 and T2. These are Tool Layers
and are purely for creating non-output shapes in your designs. These layers have no cut
parameters and will never be output to the laser. For example you could use them for:
Indicating pre-determined material size and position on your machine
Guide-lines for aligning shapes
Text on a Path (without the path being output)
Image Masking

C U TS / L AYER S
This window shows the colors currently in use in your design, and lets you quickly access the
settings assigned to them.

CutsAndLayers
The first column shows the name you’ve assigned to this layer, followed by the color, then the
Mode (Line, Fill, both, or Image). Then the speed and power are displayed, followed by the options
to enable or disable sending this layer to the laser, or displaying it in the workspace.
Underneath the layer list you can see and change the basic settings for the currently selected
layer. If you double-click an entry in the layer list, it will bring up a larger Cut Settings Editor, with
a more complete set of options.
Cuts / Layers window in depth (to be completed)

S IZE A N D P OS ITION / N U MER IC EDITS
The Numeric Edits toolbar lets you resize, position, and rotate shapes, and change the unit of
measure.

NumericEdits
The lock button can be used to maintain the aspect ratio of your objects when changing the size,
and the 9-dot control lets you choose the point that positioning and sizing happens from. The
number entry boxes accept equations and units, too - You can enter 5mm, 5in, 5", 5*3mm, and so
on, and LightBurn will calculate the correct result for you.
Numeric Edits toolbar in depth

F ON TS A N D TEX T C ON TR OL S
The font and text toolbar will activate when you use the ‘Create Text’ tool, or select text objects.

FontAndText
This toolbar lets you change the font, size, spacing, alignment, and automatic welding. It also has
settings for variable text options, like serial numbers, dates, and using data tables from a CSV file.
Fonts and Text in depth

L A S ER WIN DOW
The Laser window is used to choose the laser to use, test the position of a file (frame), run or stop
the laser, and choose various options that affect how the current file will be processed, ordered,
and positioned on the machine.

LaserWindow
Note that this window may look different for you depending on the type of laser chosen and the
options it supports, and some options will be hidden if you are in ‘Beginner Mode’.
Laser Window in depth

W OR K S PA C E / EDIT WIN DOW
Finally, the workspace, or edit window, is the drawing area where you lay out your design. The
size of the border and grid drawn in the workspace matches the available work area on your
machine. When you import artwork it is displayed here, and the arrangement of things will match
the output sent to your laser.
Next Step: Zooming, Panning, and Selection

Zooming, panning, and selection
The Edit Window, the center of the main display, can be moved around and zoomed with the
mouse to help you focus on different parts of your design.

Z OOMIN G
Scrolling the mouse wheel will zoom in or out from the location of the mouse - you can simply
point at something with the mouse and scroll the mouse wheel to zoom in on that point. If you
have a touch-pad (like a Mac) using a two-finger swipe up or down does the same thing.
You can also use the - and + keys in the upper-right of the keyboard to zoom.

PA N N IN G
To pan the view, sliding the window around, press and hold the middle mouse button and move
the mouse. If you don’t have a middle mouse button, you can hold the Space bar on your
keyboard down instead - you’ll see the mouse cursor change to a hand
grab and drag the view with the left mouse button.

, and then you can

There are buttons on the main toolbar for panning and zooming too:

PanAndZoom
The first button, the four arrows, is the Pan control. Click that to enter Pan mode, to drag the view.
You’ll see the mouse cursor change to a hand, like this:
When the hand cursor is visible, you
can drag the view around by pressing the left mouse button and moving the mouse. The Space
bar acts as a shortcut for the Pan control.
The second button is Zoom to Page - clicking this will reset the view in the workspace to frame the
entire work area, which is the view that LightBurn starts with.
The next two buttons are Zoom in and Zoom out. Clicking them will zoom in or out of the center of
the view. You can also press the - and + keys in the upper-right of your keyboard for this, or use
the mouse wheel.
The 4th button is Frame Selection - Clicking this will zoom the view to focus on whatever is
currently selected, or all the shapes in your project if you haven’t selected anything.

S EL EC TION
There are multiple ways to select things in the edit window (workspace). The simplest is to point
the mouse at the outline of a shape and click it with the left mouse button.

ClickSelect
A few things happen when a shape is selected:
The selected shape is drawn with an animated pattern instead of solid lines
The edit handles for resizing, positioning, or rotating the selection appear
The size and position of your selection is shown in the Numeric Edits toolbar
Other controls in LightBurn may activate, depending on what you’ve selected
To clear the current selection, left click an empty space in the view, or press the Esc key.
You can select a collection of shapes by pressing and holding the left mouse button and dragging
a rectangle around the things to select, from left to right, like this:

DragSelect-Enclosing
The red rectangle will disappear when you release the mouse button, and all the shapes enclosed
within it will be selected. This is called an enclosing selection - only things fully contained in the
red enclosing rectangle will be selected.
You can drag from right to left instead, and this will create a green rectangle, which will select
anything that it crosses:

DragSelect-Crossing
In this case, all three items will be selected even though they are not fully contained by the
selection rectangle.
Experiment with these two selection methods - understanding how they work, and when to use
them, makes working on larger projects much faster.

Selection Modifiers
To supplement click-select and rectangle selection, LightBurn supports these modifier keys:
Shift: Holding Shift while selecting will add the new selection to the current one
Ctrl+Shift: Holding both Ctrl and Shift will remove the new selection from the current one
Ctrl: Holding Ctrl by itself will toggle the selection state of the new selection

Additional Selection Tools
There are also a few items in the Edit menu for special types of selection:
Select All: selects everything in the project
Invert Selection: Anything selected becomes unselected, and anything unselected is now
selected
Select open shapes: Selects anything in the design that is an open shape (IE, is not a closed
path that forms a continuous loop)
Select open shapes set to Fill: Similar to Select open shapes, but only selects open shapes
that are set to ‘Fill’ - This is useful, because LightBurn is unable to fill shapes that aren’t closed, so
this can help you find them.
Select all shapes in current layer: If you choose a layer setting and click this option, it will
select everything assigned to that layer.
Select contained shapes: this is one you won’t use often, but it’s incredibly powerful when you
need it. Select a single shape in LightBurn, then click ‘Select Contained Shapes’ to add everything
that is ‘inside’ the item currently selected. For example, if you wanted to select everything inside
one of the two blue outlines below, click-select or drag-select would be difficult and time
consuming, but ‘Select contained shapes’ does it in just two clicks:

SelectContainedExample
Next Step: Basic Usage - The Essentials

Making a Simple Project
We’re going to go step-by-step through creating a small, simple project in LightBurn, from start to
finish, to show you how to use a few of the basic editing tools, and give you a feel for how things
work.
Before you start, make sure you have a laser set up in LightBurn (see Adding your laser).
This project will be a simple name tag, cut out around the letters, ideally made from thin wood or
acrylic, but a piece of cardboard will do.

Creating the text
With LightBurn running, and an empty project, click the Create Text button shown below. It
normally lives along the left side of the main window:

CreateTextButton
Next, click the mouse somewhere in the middle of the Edit window (the workspace) to get a
cursor, then type your name:

Click the ‘Select’ tool button on the top left of the edit window, or press ‘Esc’ twice (once to finish
entering text, and again to exit text entry and go back to selection mode).

SelectButton
When you finish the text, you’ll see an entry appear in the Cuts / Layers list on the upper right of
the display. This is the “layer” that your text is on, and it holds the settings that will be sent to the
laser for all the objects on this layer:

NewLayerEntry
This tells us that the shapes on this layer will be drawn as lines, with 100 mm/sec speed, and 20%
power. Depending on your settings, the ‘100.0’ might be different - Diode lasers are less powerful
than CO2 lasers, and run slower, so they tend to use mm/minute as units, so the default there
would be 6000 mm/min. If you have your units set to Inches, you might see 3.9 in/sec, or 236 in/
min.

Previewing
To see how the laser will run your project, click the Preview button in the middle of the main
toolbar:

PreviewButton
The preview window will pop up, showing the completed job, like this:

The lighter red lines are showing the laser moving between the shapes (traversal moves), and the
black lines are where the laser will burn. Click the ‘Play’ button and you can watch a simulation of
how the laser will run the job. You can also grab the slider and drag it around to see the cut at
different points in time. Spot checking the output like this is a good habit to get into, because
you’ll likely spot mistakes before you burn the project for real, saving time and material. Click the
‘Ok’ button to close the preview.
For more information on the preview window see its page here Preview Window

Changing text properties
Make sure you’re still in Selection mode - the ‘Select’ tool should be highlighted. Click the name,
or click and drag a rectangle around it to select it. When it’s selected, it will be drawn as animated
dashes instead of solid lines, and handles will appear around the selection to let you change the
size, position, or orientation.

The options in the Text Toolbar at the top will activate, like this:

TextToolbar
Click the drop down for the font, and change it to anything you like. While you are choosing, the
changes will be displayed in real time in the edit window. You can change the height, make it bold
or italic, and adjust spacing here too.

Undo / Redo
If you make a change you don’t like, you can undo it by clicking the Undo button on the toolbar
(or pressing Ctrl+Z, or Edit > Undo in the menu). If you decide you liked it after all, you can also
Redo (Ctrl+Shift+Z). Undo and Redo in LightBurn are unlimited - the undo system doesn’t reset
unless you create a new file or close the program.

Changing the Layer settings
Rather than outline the text, we’re going to change it to be solid filled. In the Cuts / Layers
window, click where it says ‘Line’ and change it to ‘Fill’, like this:

LayerSettingToFill
You’ll notice that the display in the edit window hasn’t changed, but if you run the preview again,
it looks quite different. By default, the view in LightBurn shows outlines only, not fills, because it’s
much faster, and it prevents things from being hidden behind solid shapes that might still be run
on the laser.

Adding an outline: The Offset tool
With the text selected, click the ‘Offset’ button on the left toolbar, shown here:

OffsetButton
The Offset options window will appear, and you should see something like this:

OffsetButton
The offset tool creates a new shape by outlining the shapes in your selection at a given distance,
either inward, outward, or both, and merging the result. If you point the mouse at the ‘Offset
Distance’ value, you can scroll the mouse wheel to change the number and watch the result
change on the fly. You can also click the box and just enter a number as well.
Make the Offset Distance value large enough that there are no internal gaps in the outline - Notice
the gap above between the L and the next letter is gone in the version below:

OffsetButton
When you’re happy with the result, click ‘OK’.

Changing Layers
Now, use the left mouse button to click the new outline you just made, so it is the only thing
selected, like this:

Then, click the Red button in the color palette at the bottom of the display:

ClickTheRed
The outline will turn red, and you should see two entries in your Cuts / Layers list, like this:

TwoLayersInList
The first, the black layer, is the fill for your text, and the second red layer is for the outline cut.

Speed and Power
This is where things get a little tricky for me, as the author of this tutorial. Speed and power
settings vary quite a bit between lasers, and LightBurn supports a lot of different types of
machines. It also depends on the kind of material you’re using - cutting through 1/8" basswood
uses much less power than cutting through 1/4" plywood or acrylic. I’m going to assume 1/8"
(3mm) plywood and give some guesses for settings, but you’ll probably have to change them.
To start with, click the black color entry in the Cuts / Layers window. Below the list of layers you’ll
see the Cut Info window, containing something like this:

CutInfo

For the text, you want enough power to engrave into the material you’re using, but not too deep.
If you have a CO2 laser, use 200 mm/sec, 15% power (both Power Min and Power Max - more on
this later) and leave everything else.
If you have a diode laser, use 50 mm/sec (or 3000 mm/min), and 50% power.
Understand that this is a rough starting point, and you will probably need to change this later.
Now, click the red entry in the Cuts / Layers window. This is going to be what cuts through the
material to cut out the shape. Cutting requires more power and much less speed.
For a CO2 laser, set 15 mm/sec, 75% power (again for both min and max power)
For a diode laser, use 2 mm/sec (120 mm/min), and 100% power. Depending on the strength of
the diode you have, you might need to go slower than this, or use more passes by setting the
Pass Count value higher.
Again, these are guesses, but they’re a starting point.
Open the Preview window again (Alt+P, or click the Preview button), then drag the progress slider
from left to right to watch how the job will run. You’ll see the text engrave first, followed by the
outline cut. If you don’t see those things, check the settings again, and verify that you have the
first layer (black) set to Fill, and the second layer (red) set to Line.

Positioning the Job on the Laser
When sending this to the laser, there are a couple of different ways that it can be positioned, and
the one you choose may depend on the kind of hardware you have. If you have a small diode
laser that does not having homing switches, you will likely want to run the job using the ‘Current
Position’ mode. For now, that’s what we’ll recommend for everyone, since it’s easy.
If you have an Ortur Laser Master, or other small laser that does have homing switches enabled,
you will likely find ‘Absolute Coords’ to be the simpler setting to use - this means that wherever
you place your work in LightBurn is exactly where it will go on the laser.
In the Laser window, which is in the lower-right of the main window by default, look for the ‘Start
From’ drop down box, and choose ‘Current Position’ or ‘Absolute Coords’. If you see ‘Controller
Setting’ in this window, it means you have a Trocen Controller, and the start position is set from
the controller menus, not from software. Don’t sweat it for now.

CutInfo

If you used ‘Current Position’ mode, you’ll see the 9-dot “Job Origin” control under it activate, and
you should see a green square on your design in the same spot indicated by Job Origin control,
like this:

In the above image, the Job Origin is set to the lower-left, and that’s where the green origin
square is on the design. That green square represents the position of the laser before you start
the job, so the design is going to end up above and to the right of wherever the laser is when we
press Start.
Put a piece of material in the bed of the laser, and use the arrow keys on the laser controller to
move the head of the laser to the lower-left corner of the material. If your laser controller doesn’t
have arrows, click an empty spot in the edit window, then use the arrows on the Number Pad of
your keyboard to jog the laser around instead.
When you think it’s lined up, press the button labeled ‘Frame’. The head of the laser will move in
a rectangle around where the job will go. If you need to adjust anything, do so, then Frame again.
If you only have the option for ‘Controller Setting’ in the above window, when you position the
laser in the lower corner of the material, press the button labeled ‘Origin’ on the controller panel
to tell the controller this is where you’d like the job to start.
When everything is lined up, close the lid on the laser (or if you don’t have one, put on your
safety glasses), then press the Start button.
If anything goes wrong, hit the Stop button to abort the job, but if not, let it finish. When it
completes, have a look at how things ended up - if the engraving of the name is too deep or too
dark, you can increase the speed or reduce the power (or both). If the cut didn’t go all the way
through, reduce the speed or increase the power (or both).

Results and Next Steps
When it’s done, hopefully it looks like something like this:

That’s it for this quick tutorial - It’s only meant to be a starting point, but hopefully it was enough
to give you a little foundation, and a taste of how things work.
Next Steps:
We recommend going through some of our “LightBurn Basics” tutorials on YouTube, and we have
a great project tutorial that’s a little more in depth called the “WIFI QR Code tutorial” that covers
more ground, including importing.
LightBurn YouTube channel
WIFI QR Code Tutorial

Coordinates and Job Origin
There are a couple different ways to tell LightBurn how to cut the project within the work area of
your machine. You choose them in the “Start From” box on the Laser tab:

Start From

A B S OLU TE C OOR DIN ATES
Absolute Coordinates is the simplest - The page grid you see in the main editing window
represents your machine’s work area. Anything you place in that area will be cut in the
corresponding place on your machine. Users with small lasers like the K40 will likely find this the
simplest and most intuitive option.
Note: Using absolute positioning requires a laser with homing switches and a fixed origin. If you
have a small diode laser that does not have homing sensors, you will need to manually zero the
machine. See Machines without homing sensors / limit switches.
In the image below, the two circles placed in the middle of the work area will be cut in the middle
of the machine work area. The green square in the lower-left of the image represents the Job
Origin, and the red square in the same place shows the Machine Origin. In “Absolute Coordinates”
these are always in the same place.

Coordinates Absolute Position

C U R R EN T P OS ITION
Current Position is probably the next easiest to use. Your job cuts relative to the current position
of the laser head when you hit the Start button. You use the “Job Origin” control in the Laser
window to tell LightBurn how to position the job relative to the laser.
In this image, we’re starting from the Current Position, with the Job Origin set to the lower left:

Coordinates Absolute Position
Notice that the green “Job Origin” indicator has moved. This represents the position of the laser
when you start the job, so the laser is going to move slightly up and to the right from wherever it
is, cut the two circles, and go back to where it started.

Imagine that you wanted to cut this amazing two-circle pattern onto a beverage coaster or a
phone case. Lining it up like this is not easy. If you change the Job Origin setting to “Center”, you
get this instead:

Coordinates Center
Now the job is going to be cut centered around the current position of the laser head. If you
position the laser directly over the center of the item you want to cut, the resulting image will be
centered on the item.
Using Current Position and Job Origin together lets you line up a cut on a piece of material with
ease, once you understand how it works.

U S ER OR IG IN
User Origin works almost exactly the same as Current Position, except that the starting location
is “programmable”. Some lasers have an “Origin” button on them (like Ruida controllers). GCode
based systems use the “Set Origin” button in LightBurn to do the same thing. You jog your laser to
the position you want your job to start from, hit the “Set Origin” button, and then you’re free to
move the laser around again. If you specify “User Origin” as the “Start From” value, the laser will
move back to that programmed location and start the cut from there.

F IN IS H P OS ITION
Note that the Finish Position setting is for GCode-based controllers only. DSP controllers manage
this internally.
LightBurn gives you the control of where you want the head of the laser to return to after a job is
finished. By default it will return to 0,0 however this is not the optimal location for some
machines.
To change your finish position, go to the Move tool window and use the arrows to reposition your
laser head to where you would like it to return to on job finish. Then click the Set Finish Position

button. Your machine will now remember that spot for future jobs. This can be reset at any time
by repeating these steps for a new location.

Move Tool Window

Using Specific Features in LightBurn
Coordinates, Device Origin, and Job Origin - Placing your work
Creating Shapes
Fonts and Text
Node Editing - Editing shapes
Selection
Tracing Images
Variable Text - Serial numbers, mail-merge, and more

Advanced Topics
Configuring a Ruida Controller
Engraving Images (to be completed)
Optimization Settings - Adjusting the cut order for faster cuts
Print and Cut - Perfectly registered cutting of printed shapes, or multiple jobs
Scanning Offset Adjustment - Correcting shifted fills
Using a Camera with LightBurn - aligning your work with a USB camera

Tips and Tricks
LightBurn has a decent number of user interface tricks that aren’t always obvious, so we’re listing
them here.

Pop-up tips
Nearly everything in LightBurn has pop-up text that will tell you what the control is for, and
sometimes gives additional help, like this:

Topic-aware help function
If you point the mouse cursor at a button or window and press F1 (help), LightBurn will launch
your browser and open the documentation on the relevant help page for that control. This works
for nearly all controls on the main window.
###
Reset the
window
layout
Sometimes
a window
gets
shoved off
the screen
or
positioned
in a way
that makes
it hard to
find, or
move. You
can reset
the
window
layout in
LightBurn
in two
different
ways:

- In the
Window
menu,
choose
“Reset to
default
layout”.
This will
undock all
windows,
and redock them
in the
default
order. - If
that
doesn’t do
it, restart
LightBurn
while
holding
the Shift
key - this
skips
restoring
the saved
window
layout,
and
always
works.

Edit window shortcuts
The edit window has a number of single-key shortcuts that are only active when you have clicked
in the edit window. They are:
H - flip selection horizontally
V - flip selection vertically
L, R, T, B - Align the selected objects by Left, Right, Top, or Bottom edges
C - Align the selected objects along their vertical centerlines
E - Align the selected objects along their horizontal centerlines
P - Move the selection to the center of the page
Arrow keys - Move the selection (Shift and Ctrl adjust the size of the move)
(comma) and (decimal), usually under < and > are rotate 90 counterclockwise and clockwise
Tab - Select the next shape in the shape list
Number pad arrows - Jog the laser

Snapping behaviors
LightBurn will automatically align your selection to snapping points if you see the cursor change
to a snap cursor before you click:
- The selection will snap to a point
- The selection will snap to a line
- The selection will snap to the midpoint of a line
- The selection will snap to the center of an object

Equation support in number boxes
The position, width, and height boxes in LightBurn will accept not just numbers, but also
measurements and equations. All of these are valid:
50mm, 5cm
10 in, 10"
2 ft, 2’
10.25 / 2
(10+2) * 4 + 1in
You can also use the constants e and pi, and functions like sin, cos, tan, sqrt, abs, atan, log, pow,
and more.

Copy & Paste from other applications
LightBurn can paste data in known formats from other applications.
An image copied from a browser can be pasted into LightBurn
Text copied from anywhere can be pasted into LightBurn
Shapes copied from InkScape can be pasted into LightBurn

Drag & Drop from the file browser
Files in any format supported by LightBurn can be dragged into LightBurn from your file browser
(Windows file explorer, or Finder on MacOS).

Automatic file backups
LightBurn by default will save backups of whatever file you are working on. If you have previously
saved the file as a LightBurn project, the backup will be stored in the same folder, with the same
name, but with _backup appended to it.

If you haven’t saved the file with a name yet, LightBurn will store the backups for it in you
Documents folder with the name “AutoSave_xxxx” where the x’s are a random string of
characters. If LightBurn crashes, you can usually open the most recent of these files to recover
your work.

Auto-Start a job after Sending it to the laser
Hold the Shift key when you click the Send button in LightBurn to, and LightBurn will
automatically run the file on the laser when the send is completed. This is useful if you are
sending very complex or large files, and want to be certain that the transfer completes before the
job starts running, but saves you having to press Start on the controller.

# Fusion 360 DXF Export
When designing laser cut projects in Autodesk Fusion360 the easiest file format to export is dxf.
But to do this for laser we will need to make a special sketch and export that.

S TA RT FIL E
Finish your part and save your file.

N EW S K ETC H FOR EX P ORT
Start new sketch

Create Sketch
and select the top surface of the part

Select Plane

P R OJEC T FEATU R ES
When we select the top surface of the part you’ll notice that all the connected features highlight.
These are automatically projected and their outlines will automatically get added to the sketch.
We will need to add the eye of the dragon and the inner features of the “g” and “B” from the part.
To do this start the Project tool from the Create menu.

Project Geometry
Select the islands in the part and hit ok on the project menu and Finish Sketch.

Project Islands

C H EC K TH E S K ETC H
Once you finish the sketch it will be active so you can see the contents. I like to turn off the bodies
I drew it on so I can see that all the geometry is there.

Show Sketch

S AV E A S DX F
To export the the sketch, Right Click on the sketch you created in the model tree and click “Save
as DXF”

Save as DXF

C H EC K DR AWIN G IN L IG H TB U R N
Open up LightBurn with a new file and Click Import

Import Drawing
This will bring the .DXF file into LightBurn and the contents will be fully selected automatically.

Grouped Geometry

C H EC K IN G FOR ER R OR S OR DU P L IC ATES
Occasionally you can create duplicate lines using the project tool in Fusion360. To check for this,
while the entire drawing is selected, Ungroup the drawing and use the “Delete Duplicates” tool in
the Edit Menu

Ungroup Geometry

Delete Duplicates

No Duplicates Found

A L L FIN IS H ED!!
Your drawing is ready to use

D OWN LOA DIN G L IG H TB U R N
The first step is to go to lightburnsoftware.com
At the top, click “Download and Trial” (or click here)
You’ll see links for the current release of LightBurn. Download the version that matches your
computer.
Windows 64-bit - nearly all modern computers are 64 bit
Windows 32-bit - some older systems might need this
Mac OSX
Linux 64-bit
When you’ve completed the download, you should see the file in your “Downloads” folder. On
Windows and Mac you can just double-click the downloaded file.

Installing LightBurn
Minimum computer system requirements:
LightBurn will run on Windows 7.0 or later, 32 or 64 bit, MacOS 10.11 or later, or 64 bit Linux
(Ubuntu 16+ or Fedora 28+, anything else may not work as intended).
LightBurn does not require a powerful computer for most work, though if your designs contain a
lot of images, more memory is helpful., and a faster computer will make it easier to work with
large images or complex vector graphics.
Choose your operating system:
Windows
MacOS
Linux

W IN DOWS IN S TA L L ATION
Launch the installer by double-clicking it. Windows may ask if you trust us first.

Click Next, then click ‘Install’. The installation will proceed. When it completes, you’ll see this:

If you have never installed LightBurn before, you might need to check the ‘Install FTDI driver’
button - this is mostly used by DSP controllers, like Ruida and TopWisdom, and it only needs to be
done once. If you update the software later, you do not need to repeat this step.
That’s it! Locate the LightBurn icon to launch the program
Next: Running LightBurn for the first time

M A C OS IN S TA L L ATION
Double-click the LightBurn.dmg file to mount the disk image.
Drag the LightBurn application into your applications folder
Eject the LightBurn disk image, or drag it to the trash bin
Please note that at this time, LightBurn for MacOS is not digitally signed. This means that you will
need to tell MacOS that you trust us. (Read about this here: https://support.apple.com/en-gb/
guide/mac-help/mh40616/mac)
To launch LightBurn for the first time:
Open a Finder window
Browse to the ‘Applications’ folder
Hold the Control key and click the LightBurn icon, or right-click or / two-finger tap the icon
Choose ‘Open’ from the menu
When MacOS asks if it should open the program, say yes, and it will be listed as an
exception in your launcher. From now on you can just launch the application normally.
Next: Running LightBurn for the first time

L IN U X IN S TA L L ATION
Open a terminal and run the following command:
sudo adduser $USER dialout && sudo adduser $USER tty
IMPORTANT! Log out and log back in (this refreshes the permissions we just added)
Download the Linux 64-bit version, either the .run file or the .7z file and follow the
appropriate steps below:
.run installer
Open your terminal and cd to the directory you downloaded the file to.
Run bash ./LightBurn-Linux64-v*.run
It will now automatically install and create a program listing in your desktop environment.
.7z installer
Extract the folder wherever you want Lightburn to exist
Right click AppRun > Properties > Permissions > ‘Allow executing file as program’
Double click AppRun inside your Lightburn folder
Next: Running LightBurn for the first time

Running LightBurn for the first time
Activating LightBurn
If you’ve never used LightBurn before, you’ll be shown the License and Trial page first. Here you
can either enter and activate a license key if you have one, or you can activate a free 30 day trial
by clicking “Activate Trial”. If you do have a license key, be sure to enter it exactly, including the
dashes, then click the ‘Activate License’ button. We recommend just copying the key and pasting
it into the License Key box.
You can get back to this screen in LightBurn at any time by going to the menu and clicking Help >
License Management.

LicensePage
Once you have activated your license or the trial, click ‘OK’
The next thing you’ll see is the ‘General Usage Notes’ page - this is a brief help page just to get
you going. You can get back to it any time in the Help menu, under Help > Quick Help and Notes.
Click OK.

You’re almost done!
Next Step: Adding your Laser to Lightburn

# Laser Window
The Laser Window lets you select the laser you’re using, see it’s connection status, send jobs to
the laser, and control a few different things about how jobs are run on the laser, including how the
job is positioned, and the order things are cut.

LaserWindow
The type of laser you have active will affect how this window looks, and Beginner Mode will
change it too, so don’t panic if yours looks different than what is shown here.
Start / Stop / Pause
The Start, Stop, and Pause buttons will likely get a lot of use:
Start: run the current file on the laser
Pause: pause a running job, allowing it to be resumed when you click the pause button again
Stop: immediately abort the running job
The Send button, if your laser supports it, will let you send the current job to the laser as a
named file, so you can run from the laser itself.
Framing
The two Frame buttons are used to preview the position of the job on the laser. The first is a
standard rectangular frame, also called a ‘Bounding Box’. This is the smallest rectangle that will
fully contain the shapes you’re sending to the laser.
If my current file was these four hexagons, the green rectangle around them is the path the
rectangular frame would follow:

BoxFrame
The O-Frame button, called the ‘Rubber Band Frame’, traces a path around your design that is
the shape of a rubber band stretched around it. For the hexagons file, it would look like this:

BoxFrame
This is useful for lining up jobs with irregular shapes where a simple box outline doesn’t fit well.
For example, a long, thin diagonal shape, or a triangle.
Save / Run machine files
The next two buttons will change depending on the type of laser you’re using, but they always do
the same things. The first will save the current design as a ‘Machine Ready’ file, in the file format

used by your laser. The second will load and run a previously saved file. If you have a Ruida, these
will save and run RD files. If you have a GCode based laser, these buttons will save and run
GCode files.
Home
The Home button will tell your laser to execute a homing cycle, where it moves toward the home
position looking for the switches that activate when it hits the boundary. Homing is how your laser
figures out where it is.
Go to Origin
The Go to Origin button tells the laser to jog to the position currently set as the user origin. Most
DSP controllers have an ‘Origin’ button on the panel that you press to set the current position as
the user origin. If you want to send the laser to that spot, press the ‘Go to Origin’ button.
Start From / Job Origin
These two controls affect where the job is placed on the bed of your laser. Please read the
Coordinates and Job Origin page for details on the different modes, and how they affect the
placement of your job.
Cut Selected Graphics
This toggle switch tells LightBurn to only send the portion of your design that is currently
selected. If you run a file on your machine and part of the design doesn’t cut all the way through,
select that piece, enable this switch, and click Start to re-send just the selected part of the job.
The placement of the part will not change.
Use Selection Origin
When used in combination with Cut Selected Graphics, the Use Selection Origin button tells
LightBurn that you want the origin of the job to be calculated from only the parts that are
selected, not the whole design. This is useful if you have many different shapes in a file, like a
large selection of frames, but only want to send the one you’ve chosen, and want the origin
calculated from just that selected item.
Show Last Position
When enabled, the Show Last Position button places a cross-hair cursor in the edit window at the
location of the laser head. If you jog the laser within LightBurn using any of the positioning tools,
the position will be updated. The position does not update live - for example, it will not update
while a job is running, because that would encourage you to watch the screen instead of your
laser. A laser should never be left unattended while running.
Optimize Cut Path
This toggle will enable / disable the path optimizer that plans the cutting path the laser will take.
With it disabled, the order will simply be the order that the shapes in your file were drawn in.

Optimization Settings
This button opens the Optimization Settings window, allowing you to change the various options
that control the cut planner.
Devices
Opens the Devices Window, allowing you to add, remove, or edit device profiles for the lasers you
want to use with LightBurn.

# LightBurn Bridge
The LightBurn Bridge was created by LightBurn to get around some of the limitations of Ruida
controllers. Ruida uses the UDP network protocol, which does not guarantee data transmission,
and is therefore not reliable enough to use over WIFI. Mac users often do not have a network port
on their computers, and running a network cable is often impractical or cumbersome. In addition,
Apple’s device driver for the USB connection to the Ruida has issues that often cause data loss.
The LightBurn Bridge overcomes all of this. It’s a Raspberry Pi running software created by
LightBurn to act as a relay between your PC and laser. You connect to it using TCP, so the
commands are reliably sent even over WIFI. The Bridge forwards the commands to the controller
using a short network cable, and relays responses back to your computer.
The LightBurn Bridge is simple to configure, requires no drivers, and typically sends data 50% to
100% faster than a USB connection. It looks like this:

If you purchased a kit with everything included, continue below. But if you want to setup your own
with a Raspberry Pi you already have, follow the SD card flashing instructions first.

L IG H TB U R N B R IDG E S ETU P
The LightBurn Bridge is pre-configured to connect to a laser configured with an IP address of
10.0.3.3. In the Ruida control panel, set the IP of your laser to this value, then connect a network
cable from the controller to the Raspberry Pi, and plug in the Pi with its power adapter. If you need
to change the IP address, please check out the Configuration Options, and please note the
caveats to doing this, listed there.

In LightBurn, in the Devices screen, click ‘LightBurn Bridge’ to set it up:

Create Manually

Connecting the LightBurn Bridge to your network
LightBurn will open the LightBurn Bridge discovery wizard to guide you through the setup.

On your computer or a mobile device, use the WiFi settings to find the LightBurn Bridge device,
and connect to it:

Note: The access point name you find will typically have a four-character random string at the
end of the name, such as LightBurn Bridge E4B7. This is to prevent conflicts if you have multiple
LightBurn Bridge devices in the same location.
When you’ve selected the LightBurn Bridge access point, click Next.
Note: You may also configure the WiFi manually, as shown on the Advanced Usage page.

Configuring the Bridge in LightBurn
Now you need to tell the LightBurn Bridge which WiFi network to connect to, and give it the
network password. In most cases, the configuration page on the Bridge will open automatically. If
it does not, browse to http://192.168.42.1 as shown in the wizard page below. If you want to use
your PC to configure the Bridge, click the button shown to open your browser to the correct page:

Setting the WiFi name and password
In the browser window, you’ll see a page like this:

Select your WiFi network from the list of options, enter your password, then click the ‘Connect’
button at the bottom. You’ll see a message appear near the top, telling you that the bridge is
connecting to your WiFi network. You can now close the browser window and go back to the
LightBurn wizard.
If you were using your PC to configure the LightBurn Bridge, re-connect the PC to your WiFi
network if you need to.

Finding the LightBurn Bridge from your PC
LightBurn will now scan your network, looking for connected devices, to find the new LightBurn
Bridge. You’ll see a progress bar appear as it does this:

If LightBurn is able to connect to the Bridge device, and the Bridge was able to talk to your laser,
you should see something like this:

If everything looks good, click ‘Add Device’ and you’ll be taken to the setup screen for the device,
asking you to enter the name, check the size, and so on. Click here to skip to the next section.
If the either the Bridge or the laser are not found, you may need to change the IP address on your
laser to 10.0.3.3 (the default for the LightBurn Bridge), or optionally, you can configure the bridge
to use a different address for your laser.

Name and work area size
You can name the laser, which is very useful if you have more than one, or just leave it as is.

NameAndPageSize
You must set the size of the work area for your laser so that LightBurn can make try to prevent
things from going out of bounds. If you don’t know the exact size, you can easily change this later
in the Device Settings page.

Laser Origin
The origin setting is where the ‘zero’ point of your X & Y axis meet. If you get this wrong, you can
change it later in the Device Settings page. This setting also controls the orientation of the output
- if it’s wrong, the output from your laser may be mirrored or upside down.

NewDeviceOrigin
With a DSP controller, like Ruida, Trocen, or TopWisdom, the origin corner will be the corner that
the laser head seeks out when you power it up.

All done!
That’s it - The final page will show you a summary of your choices. You can go back and fix
anything if necessary, or click Finish to create the new device entry.

Bridge-Finished
Next Step: Connecting to the Laser

Find My Laser
In the Devices page, click the ‘Find My Laser’ button, and you’ll see this screen:

FindMyLaser
Make sure your laser is powered on, connected to your computer with a USB cable, and has
completed any startup sequence it needs to, like homing. When the laser is ready, click Next.
After a short scan, LightBurn will list the devices it was able to recognize:

FindResults

In the above image, I have two lasers connected to my computer - the first, a GRBL controller on
COM9, and the second, a Ruida DSP controller on COM3. Select your laser and click ‘Add Device’.
Is your laser a GCode or DSP device? What if it wasn’t found?

GCode devices
If you have a GCode controller, you’ll be asked if your machine is an X-Carve or Shapeoko,
because there are some specific settings that need to be configured for those machines. If you
have one, click the appropriate button, if not, click ‘Other’. You may be asked where the origin of
your machine is, and if you want to home on startup. Nearly all GCode systems use the front-left
as the origin.
If your machine has homing or limit switches, enable the homing on startup, otherwise leave it
off. If you see ‘Error: 9’ in the console later, it means you’ve enabled this feature, but your
machine isn’t configured for homing.
With some GCode devices, additional configuration of either LightBurn or the controller may be
necessary.
Next: Connecting to the Laser

DSP devices
If you have a DSP controller, the next screen will ask you where your machine origin is. This is the
corner the machine goes to when looking for the homing switches when it powers up. Click the
home corner. If you get it wrong, things may be backwards or upside down, but don’t worry - you
can easily change it later.
When your laser is added, click ‘OK’ on the Devices page to exit.
Next: Software walk-through for beginners

What if my laser isn’t found?
If LightBurn can’t find your laser, it could be for a number of reasons:
Missing drivers - If your laser came with its own software, install it. Even if you don’t plan to use
it, sometimes they contain necessary drivers that aren’t included with LightBurn.
Can’t connect - Only one application can talk to your laser at once. If you run other software, like
RDWorks, Easel, Carbide Create, AutoLaser, LaserCAD, etc, make sure that software is not running
when you run LightBurn.
Networked device - LightBurn can’t automatically configure a network-connected laser. For this,
you’ll have to click ‘Create Manually’ and follow the steps.
Marlin controller - If you are using a Marlin controller, they have a variety of baud rates and
configuration options, and they take significantly longer to reset than most other controllers, so
it’s not practical to auto-search for them - click ‘Create Manually’ and follow the steps.

# Manually adding a laser
If LightBurn can’t automatically add your laser, because it’s not connected to your computer, or is
connected over a network, you can click the ‘Create Manually’ on the Devices page.

Create Manually

Device type:
LightBurn will open the New Device Wizard, and the first thing you’ll see is a list of the controllers
supported by your version of LightBurn:

Create Manually
Choose the entry that matches the type of controller or firmware in your laser and click Next.

Connection type:
The next step is choosing how you connect to your laser. The choices you see will depend on the
type of connection methods supported by your controller and LightBurn. Serial/USB is the most
common. Some controllers allow connection by Ethernet (note that this includes both WIFI and
wired).

Create Manually
Choose how you wish to connect, and click Next.

Name and work area size:
You can name the laser, which is very useful if you have more than one, or just leave it as is.

NameAndPageSize
You must set the size of the work area for your laser so that LightBurn can make try to prevent
things from going out of bounds. If you don’t know the exact size, you can easily change this later
in the Device Settings page.

Laser Origin and homing:
The origin setting is where the ‘zero’ point of your X & Y axis meet. If you get this wrong, you can
change it later in the Device Settings page. This setting also controls the orientation of the output
- if it’s wrong, the output from your laser may be mirrored or upside down.

NewDeviceOrigin
If you have a GCode based controller, like GRBL, Smoothieware, or Marlin, commonly used with
diode lasers or smaller hobby systems, in almost all cases the origin will be in the front-left. With
GCode based systems, you are given the option to send the homing command when LightBurn
first connects. If your laser does not have homing switches, leave this off.
If you have a DSP controller, like Ruida, Trocen, or TopWisdom, common in larger CO2 lasers with
metal cabinets and LCD displays, the origin corner will be the corner that the laser head seeks out
when you power it up. With DSP controllers, the controller will automatically home itself when
powered up, so you will not see the option for homing on startup.

All done!
That’s it - The final page will show you a summary of your choices. You can go back and fix
anything if necessary, or click Finish to create the new device entry.

NewDevice-Finished
Next Step: Connecting to the Laser

Common Grbl setups
If you have a GCode-based system, like a Shapeoko, Eleksmaker, X-Carve, or Acro system, you
might need to make some simple changes to get the most from LightBurn.

S H ORT V ER S ION
You might need to adjust your spindle max RPM value ($30) to match the LightBurn default (1000)
or vice versa. The value in LightBurn is called “S-Value Max”, in the Device Settings.
You might need to enable “Laser Mode” if you have GRBL 1.1f or later ($32=1)
If you have an older version of GRBL (prior to 1.1f) it’s highly recommended to upgrade the
firmware, as Laser Mode also prevents the machine from pausing with every power change. The
pause, which happens on older versions, or when not using Laser Mode, will cause excessive burn
spots when engraving images.
If your machine uses negative workspace coordinates you’ll need to apply a workspace offset
(G10 L2 P1 xx yy).
Set your machine status reporting to be relative to the workspace origin, not the machine origin
($10=0).
Make sure the controller is reporting positions in mm, as expected by LightBurn ($13=0)
If your machine does not have homing switches (also called limit switches) you will need to home
it manually if you want to use Absolute Coords or User Origin modes

G R B L FL AVOR S
Grbl firmware was originally designed for CNC machines and 3D printers, with laser support added
more recently. It is highly configurable, and this is both a blessing and a curse. The “standard”
way a CNC machine is configured is somewhat different from the way laser machines often are.
Luckily this is easy to change, and easy to switch from one to the other.
The more recent versions of Grbl (1.1f and up) support two things that are incredibly useful for
lasers. The first is Laser Mode, enabled by setting $32=1 in the firmware settings. Laser mode
eliminates the pauses that happen when changing power output, because Grbl knows it’s
controlling a laser which reacts instantly, instead of waiting for a spindle to change RPM.
The second is a feature called variable power mode, or the M4 command. In this mode, Grbl
adjusts the laser power as the machine speeds up and slows down, making for very consistent
cutting and marking. Older versions of Grbl do not have this feature, and simply run the laser at a
constant power output for the duration of a cut. Since the machine needs to slow down to take
sharp corners, this means corners get over-burnt, while long straight lines end up lighter.
This also has the benefit that when the laser comes to a complete stop, the beam turns off (zero
speed equals zero power), meaning that pausing a job automatically turns off the laser. This is not
always true with other versions of Grbl.
If you aren’t already running Grbl 1.1f (or later) on your controller, we highly recommend it for
laser use. If this isn’t an option, that’s ok, but your results won’t be as good, and pausing the laser
runs the risk of leaving the beam on and ruining the job.

Shapeoko, XCarve, and other negative workspace systems
Shapeoko machines typically use Grbl 1.1f, as do newer X-Carve and some other systems, but as
they are designed as CNC machines, they are typically configured for negative workspace
coordinates, which LightBurn doesn’t support. This is an easy thing to work around though, using
a workspace offset.
We’ll use a Shapeoko XXL as our example setup. This machine has an 812mm x 812mm working
area, and the origin is set to the rear-right, with negative numbers going down and to the left
(onto our workspace). We’re going to leave the direction alone, but change the origin position by
using this command in the LightBurn Console window:
G10 L2 P1 X-812 Y-812
That command says “set an offset” (G10 L2) in the first coordinate system (P1) of X -812 and Y
-812. (If your machine is a different size, use your width and height values in mm instead of the
812’s shown here, and remember the minus signs - those are important)
This shifts the origin point of the machine left and forward by the size of the workspace. Then you
tell LightBurn that the origin is at the front-left of the machine, instead of the rear-right, and
you’re done.
When you want to go back to using your machine for CNC use, clear the offset with:
G10 L2 P1 X0 Y0
It is simple to set these up as macro buttons in the LightBurn console window. Enter the first
command into a macro and call it “Use Laser”, and enter the second command into a different
macro and call it “Use CNC”. When you want to use your laser, click the “User Laser” macro
button, and when you’re done and want to switch back to CNC, click the “Use CNC” button.
After setting this, you will also need to make sure your machine is reporting coordinates relative
to this workspace origin, instead of the absolute machine zero. Do this by entering $10=0 in the
console.

X-Carve
X-Carve machines sold prior to January 2018 generally run an older flavor of Grbl (1.0c) which
does not support the variable power (M4) command, meaning you’ll need to use the Grbl-M3
device in LightBurn. Machines sold after that date use Grbl 1.1f, and will work with the standard
Grbl device in LightBurn if the following settings commands are entered in the console:
$30=1000
$32=1
These two lines:
Set the spindle max value ($30) to match LightBurn and Grbl’s default setting (1000)
Enable laser mode ($32=1)

Other machines
If you aren’t sure how to configure your machine, there are some simple steps to take that can
help. First, figure out which firmware you’re running. In LightBurn, when you first connect to the
machine, the console window will usually show a ‘hello’ message from the controller. For
Smoothieware boards it’s just “Smoothie”. For Grbl, it will be “Grbl 1.1f [$ for help]” or similar this tells you it’s Grbl, and which version. Machines using Grbl 1.1f or later will support the M4
variable power command, and just use the “Grbl” driver in LightBurn. Grbl 1.1e or older (Grbl 1.0,
Grbl 0.9, etc) must use the Grbl-M3 device in LightBurn.
With the driver identified, it’s time to find the machine origin. First, home the machine by pressing
the Home button (

) on the Move window.

In the console window, type
G0 X0 Y0
then hit enter. Your machine will head toward its origin position. This isn’t always the same as
where the home position is. Usually the home position is in one of the corners. Most often it will
be the rear-right, or front-left of the machine. In some cases, it might be the center of the work
area. If your machine does this, skip ahead to Center Origin Machines below.
After it stops moving, type
G0 X10 Y10
then hit enter. If your machine moves 10mm into the work area on both axis that’s good - it
means your machine uses positive workspace coordinates. You simply set the origin in LightBurn
to match the machine origin discovered above. If your machine bumped the rails, it uses negative
coordinates.
Negative Coordinate Machines
If your machine uses negative coordinate space, we need to offset the origin.
LightBurn wants positive workspace numbers, like this:

This image shows the origin at the front-left, with positive X values moving to the right, and
positive Y values heading to the rear of the machine.
A negative workspace system looks like this:

In this image, the origin is at the rear-right of the machine. The X and Y directions are the same as
before, but now, to move into the work area, you would need to use negative numbers. Instead,
we’re going to set up a work offset.

You’ll need to know the total distance your machine can travel in both axis. For a Shapeoko XXL,
for example, it’s 812mm in X and Y. For a 500x500 X-Carve, it’s 250mm in X and Y. By applying a
workspace offset that is the size of your machine area, we can shift the offset to the opposite
corner, like this:

Enter the following command:
G10 L2 P1 X-250 Y-250
in the console, and hit enter. Note that the ‘250’ above should be replaced with the total travel
width and height of your machine. If your machine had a 600mm width and 400mm height, you
would use:
G10 L2 P1 X-600 Y-400
This command offsets the origin by the given amounts. If the origin used to be in the rear-right of
the machine, and you offset it in the negative direction by the width and height of the work area,
you’ve moved the origin to the front-left.
If you enable a workspace offset, you will also need to make GRBL report its location relative to
this shifted origin, instead of in “machine space” by setting $10=0. Some systems, like Easel or
Carbide Motion, may need a different value, so it is good to remember the existing setting.
Center Origin Machines
Some systems have their origin in the center of the workspace. After homing your machine, enter
this command in the console and hit enter:
G0 X0 Y0
That command says “rapid move to coordinate 0,0”

If your machine travels to the center of the workspace instead of the rear-right you will still need
to move the origin just like in the “Negative Coordinate Machines” above, but only by half the size
of your workspace. Follow the directions for a negative coordinate space machine, but divide your
workspace numbers in half before issuing the GCode offset command.
Machines without homing sensors / limit switches
If your machine does not have homing switches (also called limit switches) you will need to home
it manually if you want to use Absolute Coords or User Origin modes. You can do this in a couple
ways:
With the machine off, manually move the laser head to the origin position (usually front-left), then
power up the machine. Until you tell it otherwise, the power-on location of the controller is treated
as the zero position.
With the machine powered, jog the laser head to the origin position. In the console window, type:
G92 X0 Y0 and press (enter). The G92 command tells GRBL to set the current location as the
specified coordinate, so you’re telling the machine “this is zero”. You will also need to set $10=0
for this to work correctly.

Configuring a Ruida
When purchasing a laser with a DSP controller installed, the factory making the machine
configures the laser controller for you to tell the controller how fast and in what directions to
move, where the homing switches are, and so on.
If you are installing a new controller into a machine, you will need to perform the configuration
that is normally done for you by the factory.
A somewhat common mistake for new users is doing a ‘factory reset’ of their controller - this
resets it to the stock configuration supplied by Ruida, not the configuration applied by the
company that set up your laser, so it’s not recommended to do this. Chances are you already
have, which is why you’re here.

R U IDA MA C H IN E S ET TIN G S IN L IG H TB U R N
With the laser connected to your computer, go to the bottom of the Edit menu and click Machine
Settings. LightBurn will open the Machine Settings window and read the configuration from your
controller. You should see this screen:

The top section of the list is referred to as user settings - these are settings that are intended to
be tunable by the user if necessary. The lower section, under ‘Vendor Settings’ are things usually
configured for you by the factory and should only be changed if you have a good reason for doing
so.
It’s also a good idea to back up the initial settings before you change them, so you can go back to
what you had if you make a mistake and can’t remember what you did.
The ‘Read’ button tells LightBurn to read the settings from the controller (this happens
automatically when you open the Machine Settings window). The ‘Save’ button will write all
settings to a file. ‘Load’ will read settings from a file back into memory. ‘Write’ commits the
settings in LightBurn back to your controller.
In the bottom of the Machine Settings window is a heading called Vendor Settings. Click it to
‘unroll it’ and you’ll see something like this:

The first section is general configuration, and then there are settings that are specific to each
axis, followed by a Laser section, for configuration specific to the laser type.

H OMIN G , DIR EC TION S , A N D TR AV EL
A DSP laser will have homing switches - one on each axis. They might be physical lever-type micro
switches, optical beam-break switches, or inductive proximity sensors. Locate the switch at the
end of the X axis, and the one for the Y axis.
When you power up the laser, the first thing it will do is move toward the corner it thinks those
switches are at to home itself. If it’s moving in in the wrong direction, you’ll have to hit the ESC
button on the controller itself to stop it.
Bring up Machine Settings in LightBurn, and go to the Vendor settings section at the bottom, and
open the X axis and Y axis Settings. Near the top of each will be three check boxes:
Invert Keypad Direction
Limiter Polarity
Direction Polarity
The first (keypad direction) controls which way the arrow buttons move the laser. The second
(limiter polarity) controls which side of the machine the laser moves to when looking for home,
and the 3rd (direction polarity) controls which way the motor moves in general.
There are only 4 possible combinations of “limiter polarity” and “direction polarity” for each axis. I
can’t tell you which is the correct combination, but change those settings for the X axis until it
moves properly when you power the machine, then do the Y axis. Once these are set, the next
steps are easier.
When the limiter and direction settings are correct, check that the keypad arrows on the machine
are moving the laser in the correct direction. If not, toggle the ‘Invert Keypad Direction’ button for
whichever axis is wrong.
You will also need to set the ‘Max Travel’ value for the X and Y axis - these numbers dictate the
length of each axis, and together define the size of the work area of the machine.

S TEP L EN GTH C A L IB R ATION
The next part is figuring out how far the laser moves when you tell it to, and how far off it is. The
controller needs to know how far a single step moves when it sends a step pulse to the motors so
it can translate real measurements into the proper number of steps.
Rough Calibration
In LightBurn, set the ‘Start From’ setting in the Laser window to Absolute Coords, like this:

img
Then draw a small rectangle at the origin. Start with 10 x 10 or 20 x 20 mm, like this:

img
Note that your origin corner might be in a different spot than mine - you should set it in the device
settings to match the origin corner of the machine.
Now, use the ‘Frame" button (shown above, near the ’Start From’ setting) and see how big it
frames. If it’s barely moving, your step size is too big (the controller thinks it is moving more than
it is). If it moves way too far, the step size is too small (the controller thinks it has to take lots
more steps than necessary).
This part is just doing rough adjustment - it’s not accurate at all, but you need to get into the right
ballpark before doing the next part.
In the Machine Settings again, in the settings for the X and Y axis, are values called ‘Step Length’
Adjust those according to what I said above - If the controller doesn’t move enough by half, cut
the step length in half. If it moves twice as far as it should, double the step length. Frame again,
and iterate until the size of what you’ve drawn and the size the laser frames is reasonably close.
Final Calibration
Now, draw a box similar to the original, but make it 100 x 100, or 200 x 200 (mm), set the Min
and Max power low to start, but high enough to make a mark, and run the job it on a piece of
scrap material. Measure the result as accurately as you can.
This time, actually do the real math with the step size:
New Step Size = (Current Step Size * Measured Length) / Requested Length
If the controller complains about ‘water protect’, you can disable the water protect setting in the
machine settings. Ditto for the door protect (it’s the lid open switch). If you have a flow meter,
you should have it hooked up so you know you have water running through the tube, and have
the water protect enabled.

As you are dialing in the above settings, if the steppers skip or make buzzing sounds, you might
need to reduce the Idle Acceleration or Idle Speed settings near the top. Those things will require
tuning with some trial and error.

Fixing Skewed Engraving
An occasional problem with new setups, and sometimes even existing machines, is lines cutting
correctly, but engravings coming out slanted or skewed, like this:

If your output looks like this, you likely have your motor pulse step polarity set incorrectly. On
Ruida controllers, there’s a setting called ‘PWM Rising Edge Valid’ that you can change for each
axis that tells the controller whether the rising edge or falling edge of a step pulse is what the
motor driver is looking for. Toggling this may fix skewed engraving.
The fix is relatively simple. In Edit > Machine Settings, look in the X & Y axis motor settings
section at the bottom, and look for the value of ‘PWM Rising Edge Valid’ on the X axis. Change
that - if’s it’s checked, un-check it, or vice versa. Then, copy the new setting over to the Y axis as
well.
What is this setting and why does it matter?
A step pulse is a transition from low to high, or high to low. The controller will hold the line low,
and pulse it high, or hold the line high, and pulse it low. The transition itself is what matters, and

motor drivers will either look for a transition from low to high (rising edge) or high to low (falling
edge) to accept as a ‘Step’.
If the laser controller believes that the motor driver is looking for the leading edge signal (when it
transitions from low to high), it will pulse the line, and could change the direction line immediately
after that. If the motor driver is waiting for the falling edge, it will see the direction change
BEFORE the falling edge of the pulse, meaning that it will change direction one step too soon.

[
In the image above, the upper line of steps is interpreted as 4 steps in one direction, then two in
the other. The lower line is interpreted as 3 and 3, and the only difference is which side of the step
signal the driver is looking for.

LightBurn Windows
This is a list of all the standard windows (and toolbars) available in LightBurn:
Main window, menus, and status bar
Main Toolbar (file, clipboard, view, settings)
Edit window (the workspace)
Arrangement Toolbar (grouping, mirroring, alignment, distribution)
Creation tools (selection, shapes, text, node editing)
Modifier tools (offsetting, Boolean operations, grids)
Color palette
Numeric Edits (size, position, units)
Fonts and Text
Cuts & Layers (how the laser treats your graphics)
Laser Control
Move window (jogging and positioning)
Shape Properties
File List
Console
Art Library
Material Library
Camera Control
Variable Text
Settings (global LightBurn settings)
Device Settings (settings specific to each laser)

Menus
The various features in LightBurn are accessed through the menus. The various features in each
menu are listed and explained here.
File Menu
Edit Menu
Tools Menu
Arrange Menu
Window Menu
Language Menu
Help Menu

File Menu
New

Clicking “New” in the File Menu will clear any current project and create a new one. You can also
press “Ctrl + N” (Command + N on Mac).
Open recent projects

This will open a list of the most recently opened files to choose from.
Open

To open an existing or saved file, click on “Open” in the File menu or press “Ctrl + O” (Command
+ O on Mac).
Import

You can import any supported LightBurn files into the file you are currently working on. Click on
“Import” in the File menu or press “Ctrl – I” LightBurn supports importing the following file types:
svg, ai, pdf, dxf, hpgl, plt, png, jpg, bmp, tiff, gif.
Save

To save a project click on “Save” in the File menu or press “Ctrl + S”. Type the name you want the
file saved as in the dialog box that opens up. To save a file with changes, but still keep the original
file intact, click on the “Save As” icon in the File menu.
Export

To export a file to a different file format, click on “Export” in the File menu. LightBurn can export
to SVG or AI format, though bitmaps and text are currently not exported.

Exit

To exit LightBurn, click on the “Exit” in the File menu or press “Ctrl – Q”. You will be prompted to
save your file if you have unsaved changes.
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Edit Menu
Undo

To undo the last editing action done on the current file, click on “Undo” in the Edit menu or press
“Ctrl + Z”.
Redo

To Redo the last editing action done on the current file, click on “Redo” in the Edit menu or press
“Shift + Ctrl + Z”.
Select all

To select all objects in the current file click on “Select all” in the Edit menu or press “Ctrl + A” (or
Command + A on Mac).
Cut

To one or more objects from the current file, select them and click on “Cut” in the Edit menu or
press Ctrl+X. This will put the object on the clipboard, and remove it from the current file.
Copy

To copy one or more objects, select them and click “Copy” in the Edit menu or press Ctrl+C This
will put the objects on the clipboard, but leave the original object alone.
Duplicate

To duplicate a selection in place, select one or more objects and click “Duplicate” in the Edit menu
or press Ctrl+D. This is an “in-place” copy and paste operation all in one, bypassing the clipboard.
This means if you already have something on the clipboard, it’ll still be there after using
Duplicate. The duplicate is placed directly on top of the original.
Paste

To paste an object from the clipboard click “Paste” in the Edit menu or press Ctrl+V. This will place
a copy of the clipboard contents in the current file. Note that LightBurn can paste text or images
copied to the clipboard from other software.

Paste in place

To paste an object from the clipboard click “Paste in place” in the Edit menu or press Alt+V. This
will place a copy of the clipboard contents in the current file in the same spot that it was in the
original file.
Delete

To delete an object select it and click “Delete” in the Edit menu, or hit the Delete key. This will
remove the object from the current file.
Convert to path

This converts a built-in shape object, like a rectangle, ellipse, or text, into lines and curves that
can be edited. Click on “Convert to path” in the Edit menu. The original shape information is lost,
so you won’t be able to change text with the text tool after using this.
Close path

In order to Fill a shape with your laser, the shape must be a closed loop, where the starting and
ending point are the same. If the start and end points are very close, but not quite connected,
“Close Path” will move them together. Click on “Close path” in the Edit menu or press Alt+C
Auto join selected shapes

Looks at the start and end points of all the selected curves, and if any of them are close enough,
connects them together into a single shape. Useful when importing DXF files, which don’t contain
connectivity information. Click on “Auto join selected shapes” in the Edit menu or press Alt+J
Optimize Selected Shapes

Attempts to fit the selected shapes to arcs and lines within a specified error tolerance. Useful for
reducing the point count in a shape, or recovering arcs from software that exports them as many
small line segments.
Delete Duplicates

This will delete duplicate items within the drawing, for example if two squares are identical and
one on top of the other, this will delete the extra square. This helps to minimize erroneous moves
and double-cuts.
Select Open shapes

This will select all open shapes in the document.
Select open shapes set to fill

This will select all the open shapes that are set to fill in the document.

Select all shapes in current layer

This will select all the shapes that are set to cut in the current layer of the document. Note that if
some of these shapes are grouped, the system may have to un-group them in order to select
them.
Settings

Clicking on “Settings” in the Edit menu will open the Settings window, where you can change
general user settings and preferences.
Device Settings

Opens the Device Settings window, for editing LightBurn preferences specific to the chosen laser.
Machine Settings

Opens an editor that allows reading and writing firmware settings from supported controllers.
Debug drawing

This is mostly an internal tool for LightBurn developers that shows the bounds of shapes being
drawn.
Convert to cut

Also an internal tool for LightBurn developers - It converts the selected shapes into the cuts that
would be sent to the laser, and makes a new shape from the result. This is not how you produce
gcode / cuts for your machine, it’s just a debugging tool for the LightBurn developers.
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Tools Menu
Many of the tools in this menu are also available as icons in the tool toolbar that by default, is on
the left side of the workspace. See Creation Tools for more information.
Select

Click on “Select” to select objects in the workspace, or to access menus and toolbars.
Draw Lines

Click on “Draw Lines” or press “Ctrl + L” to draw straight lines in the workspace.
Rectangle Tool

Click on “Rectangle” or press “Ctrl + R” to draw rectangles in the workspace.

Ellipse Tool

Click on “Ellipse” or press “Ctrl + E” to draw ellipses in the workspace.
Edit Nodes

Click on “Edit Nodes” or press “Ctrl + ~” to edit nodes of objects in the workspace.
Edit Text

Click on “Edit Text” or press “Ctrl + T” to create or edit text in the workspace.
Offset Shapes

Used to create new shapes that are offset from the current selection, inward or outward.
Weld Shapes

Fuses multiple shapes together into a single outline.
Trace Image

Opens a dialog box where you can trace the content of a bitmap image into vector graphics.
(Read more here)
Apply Path to Text

If you select a shape and a line of text, this command will attach the text to the shape, so the text
follows the path. (Read more here)
Zoom In

Click on “Zoom In” or press “Ctrl + =” to zoom in the workspace.
Zoom Out

Click on “Zoom In” or press “Ctrl + -” to zoom out in the workspace.
Frame Selection

Zoom the view to completely contain the current selection. (Ctrl + Shift + A)
Position Laser

Click on “Position Laser” to allow clicking on the workspace to move the laser head to that
location.
Rotary Setup

This will open the rotary setup dialog box. Use this to set up your rotary attachment.
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Arrange Menu
Group

Click on “Group” or press “Ctrl + G” to group the selected objects in the workspace.
Ungroup

Click on “Ungroup” or press “Ctrl + U” to ungroup the selected objects in the workspace.
Flip Horizontal

Click on “Flip Horizontal” or press “Ctrl + Shift + H” to flip the selected objects in the workspace
horizontaly.
Flip Vertical

Click on “Flip Vertical” or press “Ctrl + Shift + V” to flip the selected objects in the workspace
vertically.
Align Centers

Click on “Align Centers” to place the center points of the selected objects directly on top of each
other.
Align Left

Click on “Align Left” or press “Ctrl + Shift + Left arrow” to align the selected objects in the
workspace to the left.
Align Right

Click on “Align Right” or press “Ctrl + Shift + Right arrow” to align the selected objects in the
workspace to the right.
Align Top

Click on “Align Top” or press “Ctrl + Shift + Up arrow” to align the selected objects in the
workspace to the top.
Align Bottom

Click on “Align Bottom” or press “Ctrl + Shift + Down arrow” to align the selected objects in the
workspace to the bottom.
Align H-Center

Click on “Align H-Center” to align the selected objects in the workspace to the center of the
horizontal plane.

Align V-Center

Click on “Align V-Center” to align the selected objects in the workspace to the center of the
vertical plane.
Move H-together

Click on "H-together to move shapes like distribute, but keeps shapes together
Move V-together

Click on "V-together to move shapes like distribute, but keeps shapes together
Move to Page Center

Click on this to move selected objects to center of page
Move to Upper Left

Click on this to move selected objects to Upper Left of page.
Move to Upper Right

Click on this to move selected objects to Upper Right of page.
Move to Lower Left

Click on this to move selected objects to Lower Left of page.
Move to Lower Right

Click on this to move selected objects to Lower Right of page.
Grid / Array

Click on “Grid / Array” to create an array or grid of objects in the workspace. A window will open
allowing you to enter the parameters for the array or grid. For more details, see here.
Circular Array

Click on “Circular Array” to create an array or grid of objects in a circle in the workspace. A
window will open allowing you to enter the parameters for the array. For more details, see here.
Copy Along Path

Click on “Copy along Path” to create a set of copies of your selected shapes along a path. The
path is the last object you select, and the shapes will be copied relative to the first point in the
path object.

Push forward in draw order

Click on “Push forward in draw order” or use “Page up” key to move the selected object up one
level in the draw order. Usefull when trying to see objects on the screen.
Push backward in draw order

Click on “Push backward in draw order” or use “Page down” key to move the selected object down
one level in the draw order. Usefull when trying to see objects on the screen. “Ctrl-PgDn” or “CtrlPgUp” will send an object to the very bottom, or very top of the objects on the screen.
Note: Drawing order changes only work in wireframe (outline) rendering mode, not filled. In filled
rendering mode, the display order will always match the layer order.
Break apart

Click on “Break apart” to break selected object into individual parts. Return to top

Window Menu
Reset to Default Layout

To arrange the windows and menus back to the original default layout, click on “Reset to Default
Layout” You can use the Window menu to toggle windows and menus on or off.
Preview

Click on “Preview” or press “Alt + P” to open the preview window. It will show the current laser
project and includes information on cut distance, rapid moves, and total time estimate. Cut lines
are in black and traversal moves are red. You can toggle the display of traversal moves on or off,
as well as shading by power level.
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Language Menu
Choose the language you would like to have LightBurn use in this menu.
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Help Menu
Quick Help and Notes

Click on “Quick Help and Notes” or press F1 to access hotkey list, general usage notes and version
information.

Online Documentation

Click on "Online Documentation to access the documentation for LightBurn.
Online Video Tutorials

Click on “Online Video Tutorials” to access the tutorial videos.
Check for Updates

Click on “Check for Upfates” to make sure you are on the most recent version.
License Activation and Trial

Click on “License Activation and Trial” to launch the license dialog, where you can enter your
license key, or see the status of your trial period or license.
Enable Debug Log

This is for the developers, turn on the log by clicking on “Enable Debug Log”. The log file will be
written to your “My Documents” folder on Windows, or Documents on Mac, and is cumulative each time you enable the debug log it will append to any existing log, so it’s a good idea to delete
it after you’re finished.
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Main Toolbar

Arrangement Toolbar

The Arrangement Toolbar comes in two flavors - long, shown at the top, and shorter, shown just
below it. Both offer the same functions, but the shorter version of it is available for those with
smaller displays, to save space.
If you are using the shorter version of the Arrangement toolbar, buttons with a small triangular
mark in the lower-right corner of the button will pop-up a sub-menu with more choices, like this:

The Arrangement toolbar is mostly functions to control the placement and alignment of shapes in
your design.

Group and

Ungroup

The Group button and the related Ungroup button (below) are used to place shapes into a
container (a group) so they can be treated as a single entity when moving, resizing, assigning
layer color, and so on. The relative position and size of the grouped objects is maintained. You can
also make groups of grouped objects, creating a hierarchy of grouped shapes.
Use the hotkeys Ctrl+G to group, and Ctrl+U to Ungroup.
Grouping shapes is often used to tell LightBurn to treat the group as a single entity for an
operation, like aligning shapes, using the Boolean tools, and even for cutting, if the proper
optimization options are chosen, but the most common reason is simply to make it easier to move
and size a collection of related shapes, like different parts of an imported file or image trace.
Note: grouped shapes are not “connected” - if you draw four distinct lines, and make their ends
touch so it looks like a square and then group them, they are still four distinct lines, not a
continuous connected path. To join the shapes together, you would use the Auto Join tool.
The Ungroup button does the opposite of what the Group button does - it takes a set of grouped
objects, removes them from the group, and discards the container. The individual shapes that
made up the group are now distinct shapes again.

Vertical Mirror and

Horizontal Mirror

The mirror buttons take the current selection and flip it horizontally or vertically. You can use the
hotkeys Ctrl+Shift+H and Ctrl+Shift+V for this, or, if the Edit window has the keyboard focus, just
press ‘H’ or ‘V’ to flip horizontally or vertically.

Mirror Across a Line
This tool behaves slightly differently to the other two mirror tools in that it creates a copy of the
selected object or objects, and mirrors it (or them) across a line. The line must have only two
points, and be the last item selected.

This tool can be used if you want to create a symmetrical shape, like a bottle or heart. You draw
half the original shape, then mirror it to create the other half, like this:

Align Centers
Select two or more shapes, then click the Align Centers tool to move all shapes in the selection to
be centered over the last selected item.

Align Vertically along left, center, or right
These buttons will move all shapes in the current selection to align the left, right, or vertical
centers of the selected shapes to the last item in the selection.

Align Horizontally along top, center, or bottom
These buttons will move all shapes in the current selection to align the top, bottom, or horizontal
centers of the selected shapes to the last item in the selection.

Distribute Vertically
These two buttons will vertically move the items in the current selection to space them evenly,
either setting the same distance between the centers of each object, or setting the same distance
between edges of the objects.

Distribute Horizontally
These two buttons will horizontally move the items in the current selection to space them evenly,
either setting the same distance between the centers of each object, or setting the same distance
between edges of the objects.

Make Same Width / Make Same Height
These buttons will set all objects in the selection to the same width or height as the last selected
item. Objects will resize from their centers.

Move Selection to Corner or Page Center
These buttons move the current selection to the indicated corner of the workspace, or the center
of it. You can quickly move the selection to the page center by hitting ‘P’ after selecting. These
functions can also be found in the Arrange menu, under ‘Move Selected Objects’.
Holding the Ctrl key (Command on MacOS) while pressing one of these buttons will move the laser
to the indicated corner of the selection, instead of moving the selected objects. These functions
can also be found in the Arrange menu, under ‘Move Laser to Selection’.

Move Selection to Laser Position
This button will move the current selection to the current position of the laser head. The selection
is placed relative to the laser head based on the setting of the 9-dot corner control on the
Numeric Toolbar

Creation Tools
CreationTools
The shape creation tools are the basic ways you build stuff from scratch in LightBurn, along with
the Selection tool, and the ‘Click to Position’ tool.
The tools are:
Selection Tool
Draw Lines
Rectangle
Ellipse
Polygon
Edit Nodes
Add Tabs
Create Text
Click-to-Move
Measurement Tool

S EL EC TION TOOL
You’ll likely use this more than any other tool in LightBurn. The selection arrow is used to choose
which things in your workspace you want to change, and there are number of different ways that
selection happens in LightBurn.

Click Selection
Point at the outline of a shape and click with the left mouse button to select it. The shape will
change from solid to an animated pattern of dashes. There are several things you can tell from
this pattern:

SelectionPattern

The circle on the left is not selected. The circle in the middle is selected, and it is a simple shape,
because the pattern is just simple dashes. The two circles on the right are grouped - visible
because the pattern is a combination of dots and dashes.
The selection shown above is also comprised of unlocked shapes, as denoted by the fact that the
move, resize, and rotate controls are shown. Locked shapes, however, do not show any of these
selection controls, as shown below.

Selection Locked
The direction that the pattern animates shows the direction that the shape will be cut in (unless
you tell LightBurn that it’s ok to choose a different direction).
To clear the current selection, left click an empty space in the view, or press the Esc key.

Drag Selection
If you click an empty space in the edit window and drag the cursor, a selection rectangle appears.
Drag the rectangle out over a number of shapes and let go to select them. There are two types of
drag selection:
Enclosing Selection
If you drag from left to right, you’ll see a red rectangle. Selecting a shape with an enclosing
selection means the shape must be completely contained by the rectangle in order to select it.

DragSelect-Enclosing
Crossing Selection
If you drag from right to left, you’ll see a green rectangle. Selecting a shape with a crossing
selection means that if the rectangle crosses the shape at all, the shape will be selected:

DragSelect-Enclosing

Selection Modifiers
To supplement click-select and rectangle selection, LightBurn supports these modifier keys:
Shift: Holding Shift while selecting will add the new selection to the current one
Ctrl+Shift: Holding both Ctrl and Shift will remove the new selection from the current one
Ctrl: Holding Ctrl by itself will toggle the selection state of the new selection
(Note that on MacOS, the Command key is used instead of the Ctrl key)

Moving, Resizing, and Rotating
When one or more shapes are selected, several controls appear around them, like this:

ClickSelect
The small squares around the outside of the selection can be clicked and dragged to resize the
selection from that side or corner. If you move the mouse over one, the cursor will change to show
that the action is available.

When dragging one of the four corners, the shape will maintain its relative width to height (aspect
ratio) so it doesn’t ‘stretch’. You can override that by holding the Shift key while dragging a
corner.
When dragging any of the sizing adjustments, the behavior is asymmetric - the other side of the
object acts like an anchor and stays in place. Holding the Ctrl key (or Command on MacOS) makes
the action symmetrical, using the center of the object as the anchor instead of the other side.
The center square that appears is a movement handle - you can click and drag it to reposition the
shape, however you can also click anywhere on the boundary of the shape to do this, and you
don’t even have to select it first - Simply click the boundary, and while continuing to hold the left
button, drag the shape.
The circular arrows shown at the four corners are used to rotate the shape. By default the rotation
is “free”, however holding the Ctrl key will snap it to 5 degree increments.
When dragging, scaling, or rotating shapes, the bottom status bar in the main window will often
show feedback, like this:

RotateFeedback
Here I can see the position of my mouse, and the angle I have rotated the shape to while I’m
rotating it.

Snapping
When you move the mouse over a shape to select it, you will occasionally see the cursor change
to a small crosshair. This shows that you are over a snap point, like a corner, node, the center of a
line, or the center of a shape. If you click at this moment, the point you drag the object from will
be that snap point. When dragging an object to move it, as you get near other objects, those
objects may also snap the cursor location, allowing you to position shapes perfectly with each
other. If you are close to a grid point, the selection will snap to the grid as well.

If you do not want shapes to snap when dragging, hold the Ctrl key to temporarily turn off the
snapping behavior.

D R AW L IN ES TOOL
Click the pencil to use the Line tool. Click anywhere on the page to start a line, then move to a
new location and click again to finalize the current line at that point. This will continue until you
either click back at the starting point of the shape to close it, or click the right mouse button to
stop. You can also press the Esc key to cancel the current line.

DrawLinesExample

Measuring
A little known feature of the Line tool is that it is also intended to be used for measuring
distances. The status display at the bottom of the main window shows the length of the line being
drawn, even before you’ve completed it.
If you want to measure the distance between two points in your design, start a line at one point,
then move the mouse to the other point, but don’t click yet. Look at the status window to see the
length of the line in progress. When you have noted your measurement, right-click or press Esc to
cancel the line.

LineToolMeasurement
The status window shows:
dx: the distance along the X axis only
dy: the distance along the Y axis only
len: the length of the current line segment

It will also show the angle between successive line segments as you create them

R EC TA N G L E TOOL
The rectangle tool is used to draw squares and rectangles. Holding Shift while dragging will lock
the width and height, producing a perfect square. Holding Ctrl will drag the rectangle or square
from the center, instead of the corner.
With a rectangle selected, if you look in the ShapeProperties.md you can adjust the ‘Corner
Radius’ property to produce rounded rectangles, or frames with inward corners:

RectangleProperties

E L L IP S E TOOL
The ellipse tool is used to draw ellipses and circles. Similar to the Rectangle tool, holding Shift
while dragging will lock the width and height, producing a perfect circle. Holding Ctrl will drag the
ellipse or circle from the center, instead of the corner.

P OLYG ON TOOL
The polygon tool is used to draw regular polygons, like hexagons. Holding Shift while dragging will
lock the width and height. Holding Ctrl will drag the polygon from the center, instead of the
corner.
With a polygon selected, if you look in the Shape Properties Window you can adjust the Sides
property to change the number of sides the polygon has:

RectangleProperties

C L IC K TO MOV E TOOL
The Click-to-Move tool is a quick way to jog your laser to a location somewhere in the workspace.
Select this tool, then click anywhere on the page and LightBurn will issue a command to send
your laser there. This tool automatically turns itself off after about 10 seconds, in case you
accidentally leave it on. Trying to select a shape and having the laser move away from where you
want it can be confusing.

Modifier Tools
ModifierTools
The modifier tools, as the name suggests, are primarily used to modify existing shapes.
The tools are:
Modifier Tools
Offset
Weld
Boolean Union
Boolean Subtract
Boolean Intersection
Video Walkthrough of the Boolean Operations
Grid Array
Virtual Arrays
Radial Array
Start Point Editor
Radiused Corners

Offset
The offset tool is used to create outlines around existing shapes, either inward or outward, offset
from the original by a given amount. We use the offset tool in the ‘Making a Simple Project’ topic,
so that’s a great introduction.

The corner style option chooses how outward corners are offset:

The offset tool remembers the last set of options you used, and if you hold the Ctrl key when you
click the offset button, it will perform the offset operation using the previous settings, without
bringing up the dialog.

Weld
Clicking on the Weld icon will join all the selected shapes into a single entity that is the outline of
all the selected shapes. Note that Weld requires closed shapes, but will accept an arbitrary
collection of inputs, and tries to do the right thing, but sometimes gets it wrong. If you weld
something and the middle content disappears, use Boolean Union instead.

Boolean Union
Union is similar to weld, but works with 2 selected objects only. However these selected objects
can actually be grouped items, not just a single vector shape.

Boolean Subtract
Boolean subtract (also called Boolean Difference) will remove the area that the second selected
shape overlaps the first shape by. The order in which you select shapes will determine the
outcome. This tool also works with grouped items. If you end up subtracting the items in the
wrong order, Undo, then perform the operation again - The undo switches the order of the items,
so a simple Undo and click-again of of the Subtract button is a quick fix.

Boolean Intersection
This will create a shape from 2 selected shapes that has an outline defined by only the areas in
which the shapes overlap. This tool also works with grouped items.
The three different Boolean operations are shown here:

Union keeps the area covered by either shape - it merges them.
Difference is the 2nd shape removed from the first.
Intersection keeps the area covered by both shapes.

Video Walkthrough of the Boolean Operations
Click for a Boolean demonstration video
The above video describes in more detail how the various Boolean operations differ, and why
welding text to a circle should be done with a Boolean Union instead.

Grid Array
The Grid Array tool allows you to copy a shape (or shapes) with regular spacing horizontally,
vertically, or both, and includes options to adjust spacing, to shift odd rows, mirror the shapes,
and more.

The X and Y columns settings let you specify how many copies of your shape to make in each
direction.
Total Width and Total Height are convenience options that allow you to tell it the maximum size to
occupy/ It will set the X Columns and Y Rows values to whatever is necessary to fill the specified
size without going over, based on the other provided settings.
Spacing can be specified between edges (how much padding between shapes) or between
centers (absolute object spacing).
Column and Row Shift values let you offset alternate columns or rows, and you can mirror them as
well, allowing you to more efficiently pack oddly shaped items together, like this:

Virtual Arrays

There is also a Virtual Array option that can be selected by checking “Create Virtual Array” at the
bottom of the Grid Array dialog. Instead of making copies of the original shapes, this will generate
virtual clones of the original that stay synced at all times. When using a virtual array, the virtual
clones will render with a dashed outline and muted fill color to denote they are virtual:

Note that these virtual shapes are not selectable and will always be laid out based on the array
options you provided. However, any changes made to the original shapes are automatically
reflected in the array.

Beyond just altering the original shapes, there are many operations that can be done after the
fact to virtual arrays, all of which are available from the shape context menu. This menu is
available from any shape that is currently part of a virtual array. You do not have to select all
shapes in that array first.

Edit Array: Display the “Create Grid Array” dialog again, but for this existing array. This allows
you to modify any of the parameters and even convert it back into a normal array, by unchecking
“Create Virtual Array”.
Duplicate Array: Virtual arrays cannot be selected directly, only the shapes included in them. So
this allows you to duplicate an entire virtual array and all of the shapes in it.
Flatten Array: Convert the virtual array into a standard array where all shapes are separate
copies and no longer synced to the original shapes.
Remove from Array: Remove the currently selected shape(s) from the virtual array.
Add to Array: Add any currently selected shapes not in the virtual array to the array. Note, you
must select at least one shape that is in a virtual array and one shape that is not in a virtual
array currently.

Radial Array
The Radial Array (or circular array) tool lets you create copies of a shape (or shapes) around a
central point. This is useful for creating ornamental patterns, clock faces, and more.

You can manually enter the point of rotation, but it’s much simpler to create a shape to use as the
center point, and select that shape last. The created copies can be rotated or not - Numbers on a
clock, for example, are often left upright for readability, but roman numerals are usually rotated.

In the above example, the small center circle was selected last, and the ‘Use last selected object
position as center’ option is chosen, along with ‘Rotate object copies’ to produce the pattern.

Start Point Editor
The Start Point edit tool lets you tell LightBurn where to start cutting a shape, and in which
direction. By default, the starting point is the first point of the shape, and the direction will be the
direction that the selection marquee animates in. In the Optimization Settings, if you tell
LightBurn to choose the best starting point or best direction, it can choose a different point than
the default if it will reduce cutting time. The Start Point editor lets you force the starting point and
direction.
With a shape selected, click the ‘Start Point’ tool and you’ll see the starting point and direction
indicated by an arrow. If the arrow is gray, it means this shape is displaying the default point and
direction, but it is not forced. If you click any node on the shape, the arrow will move there, and
turn blue, indicating that the user has chosen this as the starting point and direction.

Holding Shift and clicking a point will choose the opposite direction, and holding Ctrl and clicking
the shape will clear the starting point back to the default.

Radiused Corners
The Radiused Corners tool lets you round sharp corners where two lines meet. After clicking the
Radiused Corners tool and entering a radius value below it, select a shape, then hover over a
corner. If that corner can be curved, you should see the cursor change, like this:

If you click the corner, it will be rounded to the radius you’ve chosen, like this:

# Image Masking / Cropping
If you have an image for which you would like to only engrave a portion of that image, you can
use the Image Mask feature to mask off the area of the image to be engraved. At the simplest
this is the same as doing a basic crop to the image, but you can go so much further than that with
masking.

B A S IC U S A G E
At the simplest this process consists of an image and single, simple shape:

Simple Image Mask
As shown here, the shape is using a Tool Layer which can be useful for this process as the
masking shape will not also be output. If you also need to cut along the mask then simply use any
of the normal tool layers for this process.

Now select both shapes. You can then apply a mask by either selecting Tools > Apply Mask to
Image or right clicking on the selection and choosing Apply Mask to Image.

Apply Mask to Image
Note: You cannot mask using a layer set to Fill, as the filled output would cover the visible image.
Any shape you wish to use as a mask must be either a Tool layer, or set to Line mode.
The mask will now be applied to the image as you can see below:

As you can see in the above screenshot, the selection box is still the same size as it was before.
This is because the entire image still exists, but the mask is providing a windowed view into that
image. If you select just the masking shape or the image, you can move it to reposition the mask.

No image data is lost during this process and you can still reposition the image or mask even after
saving and reopening a project at a later time. However, as you can see in the preview below,
only that part of the image that was masked off will be output:

A DVA N C ED U S A G E
What we’ve shown above amounts to merely an advance crop feature but image masking can go
much further. For example, you can mask an image using multiple shapes.
Note: When using multiple shapes to mask an image, all shapes must be on the same cut/tool
layer and those shapes must be grouped together. Otherwise the Apply Mask to Image option
will not be available.

But you can, of course, go far beyond that. Any closed shape can be used as a mask and the
easiest way to think about how that mask is applied, is that anywhere LightBurn would normally
fill that closed shape in Fill Mode will now be “filled” with the image instead. For example:

Just remember that you must group together all shapes to be used as a mask first.
Removing a Mask
If you would like to remove the masking you can either simply select, then delete the mask shape
or shape group, or you can select the image, right click, and choose Remove Mask from Image:

Using the Remove Mask from Image option will preserve the mask shape (or shape group) for
later use.
Flattening a Mask
Finally, if you would like to “bake in” an image mask, you can select the image, right click and
choose Flatten Image Mask. This will make the mask permanent, actually removing the now
unused image data as well as deleting the image mask shape. As you can see below, the
selection box is now smaller and the mask shape is now gone:

Cut Settings Window
The cut settings window in LightBurn is presented when you double-click an entry in the Cuts /
Layers window, or in the Material Library list.
The window you see may look different than this one, as it will vary based on which laser
controller you have, the type of cut you have selected, and whether or not you are in ‘Beginner
Mode’.
There are four different ‘modes’ in LightBurn that choose how the laser will render your design:
Line mode - traces along the outlines
Fill mode - fills the design with parallel lines
Fill + Line mode - does a fill, followed by an outline
Offset Fill mode - fills the design with lines that follow the original shape
Image mode - Works similar to fill, but with specific settings for images
Where ‘Line mode’ traces along the vector lines in your design exactly as they appear, ‘Fill mode’
behaves differently - it scans back and forth with the laser, turning off and on, filling the interior of
the shape with straight lines, much like you would do if you were trying to fill an area with a pen.
Given a simple hexagon, ‘Line mode’ is on the left, and ‘Fill mode’ is on the right:

Here is an example of what the cut settings window looks like for a ‘Line’ layer:

In all variations of this window, the most basic settings are displayed at the top of the window
(speed, power, output toggle, air assist, and mode). The lesser used, more specialized options
follow below, and are split into two panes - Common and Advanced.
We’ll go through the different settings used in each mode, and explain their use.

S H A R ED / B A S IC S ET TIN G S
All layers have a few settings that are the same, regardless of the type of layer.
Speed: how fast the laser will (ideally) move when tracing your design. Depending on your laser,
its firmware settings and limits, and the design, it may or may not actually achieve the speed you
request.
The next two require a small amount of explanation:
Max Power: The power level to run the laser at
Min Power: The power value used for corners, or when moving at low speed (DSP only)

Note: On GCode based systems, you only get “Max Power” - the power the laser will use when
running at the chosen speed. On DSP systems, you have the additional ‘Min Power’ setting, which
is used when traveling at low speed, or when cornering.
If you are cutting at a low overall speed (for example, 10 to 20 mm/sec on a CO2 machine) the
laser might only ever use the ‘Min Power’ setting, so it is recommended when cutting at very slow
speeds to set these both the same. If you are doing ‘surface marking’ you ideally want Min Power
to be just above the firing threshold of the laser, so corners still produce a burn, but without
scorching.
For the settings specific to each of the different modes, click a link below:
Line Mode settings
Fill Mode settings (including Fill + Line mode)
Offset Fill Mode settings
Image Mode settings

Cuts / Layers

The Cuts / Layers window in LightBurn shows the list of operations you have in your design. It’s
very common to have the layers set to be cut in this order (though it’s not required).
The view here gives a summary of the operations, showing the type (Line, Fill, Both, or Image),
the main speed and power settings, and the two toggles to choose whether the layer is output
(sent to the laser) or shown in the editor. If you select an entry in this list, the values at the
bottom of the list will let you edit speed, power, number of passes, and interval (distance between
lines when doing a fill).
The buttons to the side allow you to manipulate the list of layers:
Move - The first two buttons, “Move up / Move down”, allow you to re-order the entries in
the list, by shifting the selected entry up or down in the layer order.
Delete - The next button will delete all the content on the selected layer. Note that layers
themselves can’t actually be deleted, exactly - They disappear automatically when nothing is
assigned to this color, so you either have to assign everything using this layer color to a different
one, or delete all the shapes using this color.
Cache - The next two buttons let you copy the selected layer into a “cached” setting, and
copy the cached setting over top of the selected layer. This allows you to quickly copy the settings
from one layer to another if you need to.
If you right-click the ‘Output’ or ‘Show’ headers at the top of the list, you can quickly turn on, off,
or toggle that setting for all layers:

Right-Clicking an entry in the layer list will flash all the shapes using that color in the edit window,
allowing you to quickly see what’s using this layer setting.
Holding the Shift key and clicking a layer entry will select all shapes using that layer color. Note
that if you have shapes using this layer grouped with other shapes from other layers, the shapes
from the selected layer will be removed from the group in order to select them, so this operation
can alter your file.
Double-clicking an entry in the layer list will bring up the full Cut Settings Window, allowing you to
edit to all the cut settings, including many not shown here.

Numeric Edits Toolbar
MainToolBar
The Numeric Edits toolbar in LightBurn is used for adjusting the size, position, and orientation of
shapes or groups of shapes in your project.

XPos and YPos
The X and Y (horizontal and vertical) positions of your selection, relative to the point in your
selection indicated by the 9-dot control toward the right side of the toolbar. In the above image,
the 9-dot control is showing the lower-left corner, so the XPos and YPos values are showing the
current location of that corner of the selection.

Width and Height
The width and height of the current selection. When the lock control is enabled, the aspect ratio
(relationship between width and height) of your selection is maintained - this means that if you
have a shape that is currently 50mm wide and 25mm tall, it is twice as wide as it is tall, or it has a
2:1 aspect ratio. If you change the width to 80 while the lock is enabled, the height will
automatically change to 40, preserving the 2:1 ratio. If you unlock the lock control, the width and
height can be changed independently.
The width and height controls are followed by percentage controls which can be used to quickly
change the relative size of your selection. Enter 50 in one of the boxes, and the size will become
50% of whatever it was before.

Rotate
The rotate box is used to rotate the current selection by the number of degrees entered.

mm / in control
Used to quickly toggle between metric and imperial. Default state will depend on your current unit
of measurement.

Equation support
Note that the XPos, YPos, Width, Height, and Rotate fields can all accept equations, and the XPos,
YPos, Width, and Height controls accept units as well. This means that if you are working in mm,
but you want to create a shape that is 5 inches wide, just enter 5in or 5" into the width field and
LightBurn will convert it for you. More information about the equation support in LightBurn can be
found on the Tips and Tricks page.

Fonts and Text
Video Tutorial #2: Text Tool
Creating text in LightBurn is simple - click the Create Text tool (
somewhere on the page to get a cursor, and type.

) on the Creation Toolbar, click

When you enable the Create Text tool, the Text Options toolbar will activate as well.
With the Text tool in LightBurn you can:
Create text on the screen, or edit existing text by clicking within it.
Change font and size, alignment, and spacing
Enable / disable automatic welding
Create Variable Text objects

Font Settings
There are a number of global font settings that can be found in the settings dialog on the File
Settings page

FontSettings
Default Font - Default selected font for new documents
Default Height - Default font height for new documents
Enable Right-to-Left text support - This will automatically be enabled on first run if a Right-toLeft language is the current system input language. But it can be forced on here later if needed. It
will allow you to turn on Right-to-Left font rendering for any text.
Set SHX Font Path - Click to set directory containing SHX font files. Shift+Click to clear. See SHX
Fonts section below for more.

Text Options Toolbar
The Text Toolbar, located on the upper toolbar in LightBurn by default, is where you set properties
on text shapes, like which font to use, as well as size, spacing, and more.
The Text Toolbar looks like this:

FontsAndText

The list of fonts in LightBurn is taken from your computer system. If you want to use a new font in
LightBurn, use the facility provided by your operating system to install the font, then re-start
LightBurn.
Height - Sets the overall font height. The Height property of fonts is not exact - It is generally the
height of a capital letter X in the font, but every font has an internal size that is scaled by this
height, and the dimensions aren’t required to be accurate.
HSpace - adjusts the horizontal character spacing as a percentage of the font size. Positive
numbers space the characters out more, negative numbers move them closer together.
VSpace - adjusts the vertical line spacing as a percentage of the font height. Positive numbers
increase the distance between lines, negative numbers reduce it.
Align X - chooses the horizontal anchor position of the text - Left, Right, or Middle
Align Y - chooses the vertical anchor position of the text - Bottom, Top, or Middle. Top aligns text
to the top of capital letters, and Middle aligns to roughly the middle of the capital letters. This is
most useful when applying text to a path.

Bold - Displays the font in bold typeface, if available
Italic - Displays the font in italics, if available
Upper Case - Forces all text to be upper case
Right-to-Left - Force Right-to-Left text rendering. Must be enabled in settings. This will
automatically be set if enabled and current input language is Right-to-Left.
Welded - Enables automatic welding of characters. When characters touch or overlap, as is
common with script fonts, enabling this option will automatically weld the overlaps together.
The remaining two options are for Variable Text, like serial numbers, dates, and so on. More
information about Variable Text can be found here.

Curved Text
After creating a piece of text, if you return to Selection mode by clicking the Select tool
pressing Esc, you will see a blue dot near the text you’ve created, like this:

If you hover over the dot, your cursor will change to the bend cursor.
If you click and drag the dot, your text will bend around an invisible circle, like this:

or

Double click the dot to clear the bend and restore the text.

Text on a Path
If you want the text to follow a more complicated curve, you can use the ‘Apply Path to Text’
function in LightBurn to attach text to any shape in LightBurn. Draw your shape and your text,
then select both and go to Tools > Apply Path to Text, or right-click and choose it from the pop-up
menu:

Note that for text to remain editable you cannot delete the path, so if it is not something you want
engraved along with your design, put the path on its own layer and set that layer not to output,
like this:

Curved text and text on a path will still automatically weld, and can be used with the Variable Text
feature as well.

SHX Fonts
LightBurn also supports the use of SHX font files which are an old AutoDesk font format, mainly
intended for use with CNC machines. Most importantly, SHX fonts lack many of limitations of
standard system fonts and have the ability to define “single line” fonts, such as this:

Single Line Font
LightBurn does not ship with any included SHX fonts but there are many to be found online for
free with a quick search. Once you have SHX files downloaded, LightBurn must be told where they
are. In the Font Settings dialog, click on “Set SHX Font Path” and choose the directory where your
SHX files are located. It will not show the files as it is merely a directory chooser.
Once LightBurn knows where to load the SHX fonts from they should automatically show up in the
Text Options Toolbar font dropdown.

SHX Font Dropdown
SHX fonts are differentiated from normal fonts by the icon next to each entry:
denotes an SHX font
denotes a standard operating system font

Edit Window (workspace)

Basic Usage: The Essentials
So far we’ve done a brief introduction to the UI and covered zooming, panning, and selecting.
The next things we’ll cover are:
Creating Shapes
Importing Artwork
Moving and Sizing Artwork
Grouping
Cut Layer Settings
Controlling the Laser

C R EATIN G S H A P ES
LightBurn’s shape creation tools let you create simple shapes. Choose a tool from the left toolbar,
like the ellipse, rectangle, or polygon tools. With a tool selected, left-click in the workspace and
drag the mouse to adjust the size of the shape you’re creating. While dragging, the Shift key will
force the shape to have the same width and height, so you get circles and squares instead of
ellipses and rectangles. The Ctrl key causes the shape to be centered on the starting point,
instead of dragging it out from corner to corner. Release the mouse button to finalize the shape.
For text, select the text tool, then click in the edit window to place the cursor. Type your text, and
press the Esc key when finished.

I MP ORTIN G A RTWOR K
The shape creation tools let you make simple shapes in LightBurn, like circles, rectangles, text,
and polygons, and also give you the ability to edit and adjust them, but LightBurn isn’t intended
to be a complete artist package or dimensioned modeling tool. For that, external software like
CorelDraw, Adobe Illustrator, InkScape, or AutoCAD would be used. Photo or image manipulation
software can be used to create or manipulate image files.
When you have artwork ready in one of these programs, the next step is to import it into
LightBurn to adjust the settings. LightBurn can import the following file types:
Vector / mixed formats:
.ai - Adobe Illustrator
.svg - Scalable Vector Graphics
.dxf - AutoCAD Drawing Exchange Format
.pdf - Adobe Portable Document Format
.plt / .hpgl - Plotter / Hewlett-Packard Graphics Language
Image formats:
.png - Portable Network Graphics
.jpg / .jpeg - Joint Photographic Experts Group format
.bmp - Windows Bitmap
.gif - Graphics Interchange Format

.tif / .tiff - Tagged Image File Format
Note that not all features of every format will be supported. Vector graphics formats in particular
are incredibly complex, and using more advanced features, like pattern fills, masking, gradients,
and so on will not likely translate well when importing. LightBurn cares about shape outlines - if
you want artwork to include the advanced features, the best option is usually exporting as a highDPI image.
You can import files into LightBurn in several different ways:

Clicking the Import button on the main toolbar (
)
Using the File > Import option from the main menu
Pressing the Import keyboard shortcut (Ctrl + I)
Dragging a file from the Windows Explorer or MacOS Finder into LightBurn
Copying and Pasting an image from a browser window into LightBurn

M OV IN G A N D S IZIN G A RTWOR K
Once you have your artwork in LightBurn, the next step is usually placing or sizing it. When one or
more items are selected, you’ll see various “tool handles” appear around the outside of the
selection, like this:

In the image above, you can see 9 gray squares, and four arrows. If you hover your mouse over
any of them, the cursor will change to indicate the kind of operation that tool performs - resizing,
moving, or rotating.
Grabbing any of the four corners will let you resize the artwork from that corner, and defaults to
uniform resizing with the opposite corner as the anchor point. Holding the Ctrl key (or Command
on Mac) switches the anchor point to the center, so the object center remains in place when
resizing. Holding the Shift key allows you to resize the width and height independently, instead of
locking them together.
Grabbing any of the four side handles will let you adjust the width or height of the selection, and
the Ctrl (or Command) key switches to center anchor just as it does with corner sizing. When
moving, the status bar shows both the absolute position of the selection being moved, and the
relative distance it has moved.

The center handle is for moving the selection, though you can also click and drag any edge of any
shape to do this as well. When moving a selection, holding the Shift key constrains the movement
to be horizontal, vertical, or diagonal.
The four rotate handles allow you to rotate the object freely using the mouse. While rotating, the
relative rotation is displayed in the status bar. Holding the Ctrl key (Command on Mac) snaps the
rotation to the nearest 5 degrees, holding Shift will snap to 15 degrees, and holding Ctrl+Shift
snaps to 45 degrees.
You can also move, rotate, and resize artwork using the Numeric Edits Toolbar.

G R OU P IN G
When you create shapes in LightBurn, they’re independent of other shapes you create.
Sometimes it’s handy to be able to treat a collection of things as a single unit, to make sure they
keep their relative position and size when you’re moving them around. In LightBurn, this is called
a Group. If you select two or more shapes and click the ‘Group’ button (
), or press Ctrl+G,
you’ll create a new object that contains the original shapes. To un-group the objects so you can
edit the individual parts, select a group of shapes and click the un-group button (

), or Ctrl+U.

You can tell if a shape is in a group or not based on how it looks when selected.

Ungrouped objects are displayed with a simple dash pattern when selected, like the single circle
above on the left. A grouped shape shows a repeating dot-dot-dash pattern when selected, shown
on the three smaller circles above on the right.

C U T L AYER S ET TIN G S
Artwork imported from vector files assigns shapes to layers in LightBurn based on the colors of
the vectors in the original file. If you create your files with this in mind, it can save you time.
Layers in LightBurn are used to assign different settings to the shapes in your design. For
example:

LayerColorsExample
In the above design, black could be used for a solid, dark engraving, blue could be a very light
engraving with an outline to add definition to the text, and red would be a slow, high-power
cutting layer. The final output to the laser might look like this:

LayerColorsExample
The information shown in the Cuts / Layers window is just the basics. You can see the full set of
options for a layer by double-clicking the entry in the layer list to bring up the Cut Settings
window.

C ON TR OL L IN G TH E L A S ER
There are two windows primarily used to control the laser:
The Laser Window, shown in the lower right of the display by default, lets you select your laser,
Start, Stop, and Pause a job, Frame the design (move the laser head around the boundary of your
design to test alignment), and more.

LaserWindow
The Move Window, docked behind the Cuts / Layers window by default, gives you jog buttons and
positioning control, and the ‘Speed’ value there is used when framing or jogging the laser in
LightBurn.

MoveWindow
There are a couple other methods for moving the laser that are noteworthy:

The Click-to-Position tool ( ) on the Creation Tools toolbar lets you click anywhere in the
workspace and LightBurn will jog the laser to that point.
Note that this assumes that your laser has been properly homed - Some DIY-style machines do
not have homing switches, so using any form of absolute positioning in LightBurn requires extra
steps.
The number pad arrow keys can be used to jog the laser after clicking in the edit window
(workspace).

The Arrange menu and arrangement tools can be used to move the laser relative to artwork in the
workspace.

# Preview Window
The preview window allows you to preview the path the laser will take and verifiy your order of
operations while getting a rough idea of your final result, while giving an estimated time of how
long the program will take.
The previewed path is handled exactly like it will be sent to the laser control so the path is
effected by things like
Cut settings (Multiple passes, tabs, kerf, etc)
Layer order
Optimization settings
Cut Selected Graphics
Origin

PATH P R EV IEW
There are a few ways you can see how the job will run.

Time Slider

Time Slider
The Time Slider allows you to quickly slide through the project and understand the cut order and
path.

Play Button

Play
Play allows you to play the project in real time or sped up or slowed down based on the “Playback
Speed” slider.

Job Information
Below the Time Slider there is information about your project:
Cut distance - The distance the laser travels while on
Rapid Moves - The traverse move distance (laser not on)
Total time estimated - This is the total time estimated for the job based on the cut speeds and
travese move speeds defined in “Additional Settings” in Device Settings.

Job Info

P R EV IEW OU TP U T
Start Here
The Start here button will you allow you to start a program on the laser part way through, from
where ever the preview currently at.

Save Image
Save Image saves out an image file of the current state of the preview window.

O P TION S
Show Traversal Moves
Show traversal moves shows travel (non-laser moves) with red lines when on.

Shade According to power
The shade according to power option only works with Grayscale with Image Mode or Power
Scaling with Fill Mode

Invert
The Invert button is used to change the preview to make the lasered areas light, and the
background dark, so you can see what your output might look like on slate, wood that’s been
painted black, or any other material where the burned area will be lighter than the original
material.

# Edit Nodes tool
Video Tutorial #2: Node Editing
The Edit Nodes tool allows you to edit the nodes, lines, and curves that make up a shape in
LightBurn. Note that built-in primitives in LightBurn, like Text, Ellipses and Rectangles, cannot be
edited without converting them to a generic path object first using Convert to Path.

Node Edit
Action

Windows / Linux

Mac OS

Notes

Smooth corner node

S

S

while
hovering
over a
node

Convert line to smooth curve

S

S

while
hovering
over a line

L

while
hovering
over a
curve

C

while
hovering
over a
node

D

while
hovering
over a
node

D

while
hovering
over a line

I

while
hovering
over a line
or curve

M

while
hovering
over a line
or curve

B

while
hovering
over a
point

Convert curve to line

Convert smooth node to corner

Delete node

Delete line

Insert node point

Insert node at midpoint

Break shape at point

L

C

D

D

I

M

B

Action

Windows / Linux

Mac OS

Notes
while

Trim line

Extend line

T

E

T

E

hovering
over a line,
trim line
under
mouse at
next
intersection
while
hovering
over a
point,
extend line
from point
under
mouse to
intersection
with
another
shape

Video Tutorial: Trim and Extend

Snapping
Note that in all of the above tools, when creating a new shape, you will occasionally see the
cursor change if you hover over a point on an existing shape. This means LightBurn is going to
snap what you’re about to make to that point. You can bypass this behavior by pressing the Ctrl
key (Command on MacOS). LightBurn will snap to object centers, end points of lines or curves, or
center point of lines or curves, in addition to just snapping to the grid.

Paths and Shapes - Convert to Path
In LightBurn, all vector objects are stored as paths - a series of points connected by lines or
curves. If you use the Draw Lines tool, you are directly creating what LightBurn calls a Path shape.
Path shapes are the “lowest level” thing you can make in LightBurn.
Rectangles, Circles, Polygons, and Text shapes are different - They store the information used to
build the path, and if any of that information changes, the path is discarded an re-built from
scratch.
For example, Rectangle shapes know their Width, Height, and whether the corners have a radius.
If you edit the ‘Corner Radius’ property on a rectangle shape, the path that LightBurn has built is
thrown away, and a new one with the new radius is created. Similarly, if you change the font
applied to a text shape, the old version of it is discarded and a new one is built using the new
font.

If you want to node edit a shape, it has to be a path shape - using the Convert to Path function in
LightBurn on a built-in shape type tells LightBurn to turn it into an editable thing that is just points
and curves, and that it’s ok to throw away the information about the original type of thing it was.

Tracing Images
LightBurn has a feature that will trace the outline of a bitmap image and convert it to a vector
graphic. This works best for content that has very clear edges, like a silhouette or a cartoon. It
does not work very well for photographs, though with some cleanup those may be usable as well.
We have an excellent tutorial video for this feature on our YouTube channel here: Image Tracing
Tutorial
To start, import an image object into LightBurn, select it, then choose Tools -> Trace Image from
the menu (or press Alt-T). You can also select an image, then right-click and choose Trace Image
from the pop-up menu.

You’ll be presented with the Trace Image dialog, with your image showing in the window, like this:

In the image above, the purple lines are the vectors that LightBurn has produced from the image
being traced. If you want to be able to see them more clearly, click the “Fade Image” button, and
the image will dim. You can also zoom and pan using the same controls as the preview window
(mouse wheel to zoom, and click-drag the view with either left or middle mouse).

Controls
The preview window can be panned and zoomed just like the edit window, using the middle
mouse button to pan and the mouse wheel to zoom. Double-clicking the middle mouse button
resets the view.
The Cutoff slider controls the lower end of the range of values that LightBurn will outline with
vectors, and the Threshold slider sets the upper end. The default is 0 to 128, which traces
around all values in the range of 0 to 128 brightness, excluding lighter values in the range of 129
to 255 brightness.
By adjusting these two controls, it is possible to trace around a narrow range of the image.

Selection range

By clicking and dragging within the trace window you can specify a portion of the image you
would like to trace. Once the area is defined, you can grab and drag a corner of it to adjust, or just
single-click to reset it.

Ignore less than

This setting tells the vectorizer to ignore anything smaller than this many pixels in area. If you are
trying to vectorize a noisy image, increasing this may help.
Smoothness

Bitmap images are made of pixels, and pixels are rectangles. Image tracing tries to infer shapes
from these arrangements of rectangles, and has to smooth out the results or everything would
just look like stairs. Part of the process is trying to recover smooth shapes from jagged lines, and
this number controls how aggressive the smoothing is. A value of 1.333 is the maximum, and will
make almost everything into curves. A value of 0.0 will produce all straight lines. The difference is
shown below:

Notice in the left image, with a Smoothness of zero, the area highlighted in red is made of several
line segments, whereas the same area in the right image is a continuous curve. The area shown in

blue is also sharp in the left image, but with the Smoothness value set to maximum, the image at
right shows how even sharp corners become smoothed, and this is rarely desired. The default
value of 1.0 is a good mix between producing smooth curves while still maintaining sharp corners.
Optimize

After generating lines and curves, the image trace feature will attempt to merge similar lines and
curves together to reduce the node count of the result. The Optimize parameter controls how
aggressive this is. 0 means no merging. The default of 0.2 is a nice balance between accuracy of
the result and node count.
Fade Image

Dims the image to make it easier to see the resulting vector shapes
Show Points

Enables the display of the points (nodes) of the resulting vector trace. Enabling this is useful when
you are tuning the Optimize parameter to see the resulting points.

# Variable Text in LightBurn
Variable text is a feature that allows you to use special codes in your text entries that will be
substituted for something else when you send the data to the laser (or the preview). Variable text
can be used for:
Date or time stamps
Serial numbers
Displaying cut settings
Merging a CSV file into your designs
In all of these cases, the text in LightBurn is set to one of the dynamic text modes, and the text
entered is used to tell LightBurn what you want it to display. You select the text mode like this:

VariableTextDropDown
With the mode selected, you enter one of the special codes for that mode, and when you preview,
save, or send the file to the laser, LightBurn will replace the text with the desired output.
The different formatting codes are listed here: Variable Text Formats

VA R IA B L E TEX T MA N A G ER
If using serial numbers or a CSV file, you have additional controls, available in the Variable Text
window in LightBurn, shown below:

Variable Text
The values shown are:
Current: The current serial number, or row from the CSV file, that will be displayed.
Start: The first serial number you want to use, or the first row in the CSV file to be used.
End: The last serial number to use, or the last row in the CSV file to use.
Advance by: Imagine you are creating a series of numbered labels. Rather than cutting each one
separately, you would most likely want to do several at once on a page. The “Advance by” value

tells LightBurn how many entries to advance ahead when you click the Next or Previous buttons,
or when it automatically advances to the next page for you.
The buttons on the right are for:
Previous: Go to the previous page of values (decrements the Current entry by the ‘Advance by’
amount)
Next: Go to the next page of values (increments the Current entry by the ‘Advance by’ amount)
Test: Displays the text that will be output, for as long as the button is pressed.
Reset: Resets the Current value to the Start value
Auto-Advance: When this switch is enabled, each time you press one of the ‘Start’, ‘Send’ or
‘Save as..’ buttons in the Laser window, LightBurn will automatically advance the Current value by
the ‘Advance by’ amount. If you are running a large batch of parts, names, serial numbers, etc,
each time you send a job to the laser the software will advance to the next batch.
There is a property on text objects called Offset which controls is added to the current variable
text index when evaluating the text object. This allows you to have text objects on your design
that display different serial numbers, or different rows from the CSV file.

VariableTextOffset
If you created a design with 4 name tag labels on the page, you would set the Variable Offset
value for each of the four labels to 0, 1, 2, and 3, and tell the Variable Text manager to advance
by 4 with each run.

Automatic Arrays
When copying a text shape using Grid Array, Circle Array, or Copy along Path, LightBurn can
automatically advance the ‘Offset’ value on your variable text objects for you. In this way you can
quickly create full sheets of items containing serial numbers or CSV file references.

Engraving Images

Optimization Settings (the Cut
Planner)
Video Tutorial on YouTube - Click here
The cut planner gives you a great deal of control over the ordering of your cuts - you can let
LightBurn try to choose the best path for you, order it piece by piece yourself, or somewhere in
between. The new options are powerful, and we’ll have a video coming soon to demonstrate
them. If you have “Order by Layer” as the only entry in the list at the top (the default), it will
behave the way you’re used to. After selecting your choices in the cut planner, use the Preview
(Alt-P) to see how your choices have impacted things by using the slider at the bottom of the
window.
Access these settings by pressing the Optimization Settings button shown here:

OptimizationSettingsButton
The settings are displayed in this dialog (and the defaults are shown here):

CutPlannerSettings

Order By
You can select what the initial ordering parameters will be. You have a choice of Layer, Groups or
Priority. As well you can use a combination of these three choices in any order you wish.
Note that the order is important. If you order by layer, then groups, the list of shapes will be split
into lists by layer first, then those lists will be sorted by group, and finally, the remaining
optimizations will be applied. If you order by groups first, then by layers, the list of shapes will be
first split by root-level groups, then the shapes within each set will ordered by layer, and so on.
This is good for doing large projects where you want an entire multi-layer item to complete before
moving on to the next, in case you have to interrupt the project, or something goes wrong.
Each ‘Order By’ option produces a set of outputs that is then fed into the next option (if any), and
so on. Each resulting set is then optimized with the additional options (like inner shapes first,
reduce travel moves, etc).
Order By Layer

If you choose Order By Layer, the cut planner will apply all remaining optimizations to the first
layer, then the second layer, and so on.
Order By Groups

If you choose Order By groups the cut planner will apply all remaining optimizations to all the
objects in a root-level group, then the next Grouped object, and so on. Objects not part of a group
are treated as being in a group together.
Order By Priority

If you choose Order By Priority, the cut planner will apply all remaining optimizations to the
objects with the highest priority (Assigned in the Shape Properties Window) first, then the next
lowest and so on.

Optimizations
These optimizations are applied to each cutting set of outputs from the above ordering as a set.
Cut Inner Shapes First

As the name implies, if there is an object within another object, and both are being cut, it will cut
out the inside object before the outside one.
Cut In Direction Order

This will try to cut the shapes in your project in the specified direction - top to bottom, left to right,
etc.
Reduce Travel Moves

This will have the cut planner try to order the cuts in a way that it will choose objects beside each
other to try and reduce non cutting travel moves.

Reduce Direction Changes

The cut planner will try to choose nearby cuts that allow it to keep moving in the same direction,
which keeps the laser moving faster.
Hide Backlash

This option is similar to the ‘backlash repay optimize’ setting found in RDWorks - It produces a
cutting order that reduces or eliminates the misalignment between the start and end points of a
cut caused by loose or flexing belts, or other forms of play in the mechanical parts of the laser.
Enabling this option will force some of the other options to give it the most flexibility when
planning the cutting path.
Choose Best Starting Point

Allows the system to start a cut at any point within a shape, not just the first point. Works best
when “reduce travel moves” is also enabled.
Choose Corners, If Possible

The cut planner will attempt to start a cut at a sharp corner to minimize burning or staining on the
surface of an item.
Choose Best Direction

The cut planner will attempt to choose the best direction to cut in.
Remove Overlapping Lines

The cut planner will remove lines that overlap each other that would cause the laser to cut in the
same place twice. This will remove any line fully covered by another line, but will not yet remove
partial overlaps, like this:

Optimizer-PartialOverlaps
(the lines are offset from each other slightly here to be able to see them)

Print and Cut with LightBurn
“Print and Cut” normally refers to the ability to print a design on a printer, then have it
automatically cut it out with a blade or laser cutting machine by using registration marks on the
print to align the cut to it.
Print and Cut in LightBurn is used to align your current project to something you’ve previously
output. The most common use for this is, as above, printing a file with a design on it and then
using the laser to cut out the design, but it can also be used to align multiple jobs on your laser.
You can use it to register two halves of a large job with each other, for example, to cut something
larger than your machine. We have a tutorial that shows how to do this here: Cutting a single
project larger than your laser
You can also use it to register multiple passes over the same job - For example, you could use
your laser to lightly engrave an outline, remove it from the machine to paint it, then put it back in
the machine, align it using Print & Cut, then engrave a different area in the same project.
Note: In order for the output to be positioned correctly on your laser, you must use Absolute
Coords as the positioning mode, otherwise the output will not match the position of the print.

R EG IS TER IN G A P R IN TED FIL E WITH A L A S ER C U T JOB :
As an example, take this design, printed on sticker paper:

I’ve imported the same design into LightBurn, with the cross-hair markers, and added an outline
to the dragon using the offset tool:

The important part in this file is the two cross-hair marks - these are the target marks that you will
use to align the cutting path with the printed sticker. They don’t have to be cross-hairs, but these
are simplest to align with, as the center of the selected object is what is used for alignment when
recording positions. Each target marker must be a single object that can be selected - If you draw
two lines to make a crosshair, group them.
The red lines are set as cut vectors, with an appropriate power and speed, and the black lines can
either be set not to output, or simply deleted.
After placing the printed version of the file in the laser, follow these steps to align the laser output
with the print.
Using the red-dot pointer of your laser, jog the laser head to align with the center point of one of
the two cross-hair marks.
In LightBurn, select the same cross-hair mark, then go to Tools > Print and Cut > Set First Target
Location, like this:

Now, jog the laser to align the red dot pointer to the center of the second marker.
In LightBurn, select that second cross-hair mark, and again choose Tools > Print and Cut > Set
Second Target Location:

You will notice that in the above image, the menu option for ‘Set First Target Position’ has the icon
highlighted as well - this means that the First Target Position is set and active.
After setting both targets, the menu will automatically enable the ‘Align Output to Targets’ option
for you, like this:

PrintAndCutAlign
You will also see the “(Print & Cut mode)” message in the status window, like this:

PrintAndCutReady
If you preview at this point, the orientation of the preview should match that of the print on your
laser:

AlignedPreview
In the above image, you can see the preview image is rotated slightly clockwise, matching the
orientation of the printed image in the laser.

Note: In order for the output to be positioned correctly on your laser, you must use Absolute
Coords as the positioning mode, otherwise the output will not match the position of the print. The
accuracy of the result will be affected by the accuracy of your red-dot pointer, so using one that is
either a cross-hair beam pointer or a red-dot marker that is in the same beam path as your laser
is ideal.
After running the job on the laser, this is the result:

PrintAndCutOutput
When finished, you can turn Print & Cut off by un-highlighting the ‘Align Output to Targets’ option:

PrintAndCutAlign
That will turn off the Print & Cut mode.

Using sharp corners in your file instead of targets
The Print & Cut feature measures the difference in position, orientation, and scale between the
two positions you mark with your laser and the corresponding positions you select in the software.
You do not actually need to output the markers in LightBurn, they simply need to exist so they can
be selected.
The sticker image shown above has a very sharp corner at the tip of the tail, and one on the lower
jaw - These would be acceptable locations to use as alignment targets as well, which would allow
you to register to a job even without visible registration marks:

By putting the markers on the green layer, then setting that not to output, they’re available in
LightBurn to select, but wouldn’t be part of the actual cutting job sent to the laser. When aligning
to the first target, you’d point the red dot at the tip of the tail, and in LightBurn select that marker.
Then repeat the process by pointing your red dot at the tip of the lower jaw, and select the marker
in that location in LightBurn.

Scanning Offset Adjustment
Modern lasers are capable of moving very fast, and with remarkable precision, however firing the
beam still takes time. Some power supplies and tubes may respond in microseconds, but others
take longer. At higher speeds, belts will pull slightly as well, and all of these things can cause the
output of the laser to shift slightly when engraving.
At 100 mm/second, 254 dots per inch means your dots are 0.1mm in length, fitting 1000 of them
in 100mm. At 100 mm/sec, if your power supply and tube take 1 millisecond to fire, your
engraving will be offset by a full dot width.
At 500 mm/second, that 1 millisecond delay means you’ll be off by 5 dots, or 1/2 a millimeter. Still
not very much, but visible. Adding a bit of mechanical stretch to this will increase the offset.
The result often looks like ghosted edges. The image below is a 20mm square at 1000 mm/sec,
with a 1ms delay, resulting in a full mm of skew between scans:

LightBurn has a setting to counter this, called Scanning Offset Adjustment, in the Device Settings.
Other software may refer to it as ‘Reverse Interval’ or ‘Reverse Compensation’:

Device Settings Window
To use this feature, you need to measure the response of your machine at a couple of different
speeds. Create a small rectangle in LightBurn, 50mm wide and 10mm high, set it to scan, and set
the interval to 0.5mm. If you are on a GCode based device, enable overscan, and set it to 5% or
greater to be sure the machine is not slowing down before reaching the ends. (Ruida devices
overscan automatically). Note that in the image below I have power set to 0 - Don’t do this. You
will need to set the power high enough to mark your material.

Run this rectangle at multiple speeds, like 100mm/sec, 200mm/sec, 300mm/sec, and so on.
Depending on your hardware you may not even need to use these settings, however here is
example output from a machine that does:

To compensate for this, measure the distance between the ends of the lines at each speed, and
enter the speed and distance values into the scanning offset adjustment table. LightBurn will use
this information to compute the correct adjustments for other speeds as well. A minimum of two
measurements are needed for it to work. Note you will need enter half the measured value - The
software moves each line by the amount you specify, so each pair of lines only needs to move
half the distance.
There is an excellent tutorial online at Cartonus.com here: http://cartonus.com/how-to-improveengraving-quality-of-laser-machine/
You may need to do this multiple times, making minor adjustments to get clean results at each
speed. After entering the measurements for the above speeds, the resulting corrected output
looks like this:

Line Wobble
A different, but equally common problem, is line wobble, often caused by too high an acceleration
setting. When doing the test cuts above, you may notice lines that look like this:

If so, your machine is moving too quickly between the rows, and you’re seeing physical “bounce”
in the gantry because of it. Lowering the acceleration setting for your Y axis can correct this.

U S IN G A C A MER A WITH L IG H TB U R N
LightBurn’s camera feature allows you to use a USB connected camera with LightBurn to:
Position designs on material
Trace simple artwork from the camera image
Monitor your laser
In LightBurn, enable the ‘Camera Control’ window by going to the Window menu and selecting it.
You’ll see a window that looks like this:

If your computer has a compatible USB camera connected, it will appear in the Camera drop-down
box. Select the camera, and the view from the camera will appear in the window, as shown:

This image is fairly distorted, because the camera used here has a fish-eye lens. LightBurn will
correct for this, as well as mounting at odd angles, and will simulate a clean, top-down view of
whatever is on the bed of your laser. It takes a bit of effort to set up, but it’s worth it.

M OU N TIN G A N D FOC U S IN G
If your machine already has a camera installed, you can skip this part. If you are installing the
camera yourself, there are a few key things here worth noting.
The ideal mounting position for the camera is directly above the center of the bed of the laser,
with the bed completely in view (similar to the image shown above). We generally recommend
mounting on the inside of the lid, when opened, like this:

The camera should be focused as well as possible. Most LightBurn cameras are manually focused
by twisting the lens.

The camera must be solidly mounted such that it is always in exactly the same position when
using it, relative to the work area of your laser, and the top of the material. If you mount to the lid
of your laser, make sure the lid opens to the same place every time - gas struts have a bit of play
in them, so using a cord or rod to ensure the lid is always at the same position when opened can
help.
If your camera is in a mount, make sure it does not move within the mount. A small piece of EVA
foam or even tissue can hold the camera securely in the mount.
Make sure that wherever you choose to mount the camera that it is out of the path of the laser
head, and that you run the cable so it is not in the path of the beam. Ramming the laser head into
your shiny new camera is a great way to increase your blood pressure.
Focus the camera so as much of the bed is in focus as possible. Some cameras, like the 5mp-60,
have a narrow focus depth, and if mounted high, can be tricky to focus. If this happens, focus on a
circle that is roughly half-way from the center of the bed to the edge of the image, like this:

Note: the camera plugs in to your computer, not the laser. If you need a longer cable to reach the
computer, you’ll need what’s called an ‘active’ or ‘amplifying’ cable that repeats the USB signal
and boosts it. USB cables are only rated for a distance of 5 meters (about 16 feet). Any longer and
the signal needs to be boosted. If you do purchase one, make sure you get one that is USB 2.0
rated.
Also note: the camera system depends on the camera being in the same position relative to the
work area of your laser and the same distance from the top of the material. If your laser uses a
variable focus distance instead of a variable height work table, you will need to align for the
material height you are using.
The camera system also requires the use of Absolute Coords mode, so LightBurn can accurate
position the work. If you use an older Trocen controller, they do not allow setting this mode from
software, so you must change the working mode through the controller menu.

C H OOS IN G A C A MER A
The best choice of camera for a given machine depends on a couple factors:
The size of the working area of the machine
The height above that working area that you mount the camera

LightBurn can help make the decision. Open the Help menu in LightBurn and choose ‘Camera
Selection Help’. LightBurn will use the size of the selected laser and the information it knows
about our cameras to show a list of the minimum mounting heights for each camera we sell, like
this:

The image above shows the minimum mounting heights for all cameras, given the size of the
machine entered at the top. Choose a camera that needs about 50mm (2") less than the distance
from your laser bed to the mounting location, just to give you a bit of room for adjustment.

C A MER A C A L IB R ATION
There is a YouTube video of the calibration process here: LightBurn Camera Calibration
Walkthrough
In order to use the camera for work placement, it’s necessary to “teach” LightBurn how to remove
the distortion from your camera lens, and where your camera is in relation to the work area of
your laser. The first part of this is accomplished in the Lens Calibration wizard.
You will need to download and print the following image: Calibration-Circles.png
The circles image will be approximately 148mm x 105mm (5.8" x 4.1“), and should have at least
6mm (1/4”) of white space around the pattern.
Mount it to stiff card, foam-board, or wood, so the image remains very, very flat. If the image is
curved, it will affect the calibration process and reduce the accuracy.

The Camera Lens Calibration wizard
Camera Lens Calibration uses series of captured images of a known pattern. The software
analyzes how the pattern appears in the images, and compares that against its internal
knowledge of how the pattern should look. It determines the amount and shape of distortion
produced by the lens of the camera, and computes an inversion for this distortion.
Note: This process is dependent only on the camera and lens, not on its placement in your
machine - as long as the camera and calibration pattern are perfectly still, you do not need to
mount the camera in the machine to perform the lens calibration. If the calibration image cannot
be held at the appropriate distance to match the shown image in the display, you may shrink or
enlarge the printed pattern.
Important: If your machine has a honeycomb bed, or something similar to the image below with
a lot of visible circles, it will likely be necessary to cover it with something. The pattern finder is
looking for circles, and if it finds anything that looks like thousands of them, it gets confused.
It is best to have good, consistent lighting for the capture process, and the camera should be in
focus. A fuzzy image, or shadows falling across the calibration pattern will make the process much
harder, if not impossible.
Open the “Tools” menu and choose “Calibrate Camera Lens” from the menu. You will be presented
with a screen like the one below.

Choose your camera in the list, and you’ll see the view from the camera in the area to the left.
With the correct camera selected, click Next.
The view will change to include a capture button, and a helper image to show you how to position
the printed pattern for capture. For the first capture, place the pattern in the center of the field of
view of the camera, with the printed face of the card pointed directly at the camera, as shown in
the small view up top. If you cannot easily match your capture image with the suggested image,
you may need to adjust the scale of your printed card, or leave the camera out of the machine for
lens calibration.

Click the Capture button (highlighted above) and you should see something like this: (note that
we’ve removed the camera from the machine for this one)

Above the image on the right you see:
M

M M

M

M

M

M attern found - Score: 0.09 - Great! Click Next

This tells you:
The image was successfully captured
The resolution of the captured image is 1600 x 1200 (higher is better)
The calibration pattern was found in this image
This image scored very well - Lower scores are better. In this image, after distortion removal, the
positions of the dots in the image align with the positions of the real dots with an average error of
only 0.09 pixels - That’s very good, and well within our desired score of 0.3 pixels of error.
Notice that in the gray image that appears to the right, the pattern of circles is not distorted,
though the image around them is considerably worse (look just above the dots). That is
temporary, and the result of only having a single calibration image to work with. As you progress
through the remaining calibration steps, you’ll capture more images with the pattern in different
parts of the camera view, filling in more information about how your lens distortion affects the
image.
If the calibration pattern is not found, LightBurn will tell you so. Make sure the pattern card faces
directly toward the camera, and occupies roughly the same amount of view area shown in the
“suggestion” image. The pattern card should be parallel with the sensor of the camera, as shown
in the upper-left graphic in the capture window, though the pattern can be rotated within the view
without affecting the calibration if this is easier, as shown here:

As you advance through the captures, the suggestion image will update. The first five images are
the center of view, followed by bottom, left, right, then top. If your camera has a very strong
fisheye effect, it may be necessary for you to move the non-center images inward a little to get a
successful capture. This is ok.
The final four images are the corners, and these can be difficult to capture with high-distortion
cameras. If your first 5 images score very well (below 0.3) you are allowed to skip the final four
images (the ‘Next’ button will shows as ‘Skip’ in this case). If you are having trouble capturing the
last four images and don’t have the option to skip, you can place the card anywhere within the
view and capture that instead - We don’t verify that your placement matches what we’re
suggesting.
Even after only a few good captures, the image on the right should appear to be free of lens
distortion, as shown here:

A poorly calibrated result will still show lens distortion, and may have other artifacts, like the
“wobble” seen in the lower-left of the gray image below:

If you don’t get it straight away, you can re-capture the current image, or just go back to the
beginning and try again. It can take a few tries to get a feel for how to align the card with the
camera to get the lowest score.
When you have advanced through all the steps, and you are satisfied that you have a good
calibration result with a nicely undistorted image, click Finish to save the results. You can also
click the “Align Camera” button in the final page to take you to the next wizard automatically.

A L IG N IN G TH E C A MER A A N D WOR K S PA C E
Now that the camera is calibrated, you can move on to the next step, camera alignment - telling
LightBurn where your camera is in relation to the workspace of your machine. From this step
forward, it is very important that the camera not move in relation to the machine. It is possible to
mount the camera to a movable piece of your laser, like the cover, as long as the position of the
camera is the same when you use it as it is when you calibrate the alignment. The camera should
be firmly mounted pointing at the center of the machine work area, with a clear view.

Cutting the Alignment Markers
In the Tools menu, choose “Calibrate Camera Alignment” to start the alignment wizard. Choose
the same camera you did in the Lens Calibration wizard.
After selecting the camera and verifying that you can see an image from it, click Next and you’ll
get to this screen:

This page uses your laser to cut a target pattern onto a piece of material, such as card stock,
paper, cardboard, or thin wood. The pattern that will be cut is shown on the right side of the
display.
LightBurn supports many different types of laser, so we need you to specify how fast and at what
power to do this cut. You should choose settings that will make a dark surface mark on the
material, but not cut through it. The “Support Height” and “Material Thickness” values can be set
to zero if you do not normally use these values when cutting.
Follow the directions in order - set the numbers appropriately, use the Frame button to check that
the material is aligned with the cut, and click Start when you’re ready. If the cut comes out
incorrectly (too light, or too strong) change the settings and try again. Your results should look
something like this:

When you have a good result, click next.
Capturing the Target Marker Image
From this screen, you’re going to capture the alignment image. It is very important you do not
move the target marker image after cutting it. Use the jog or “send to corner” buttons here to
move the laser out of the view of the camera. When the camera has a clear view of all four
targets, click the Capture button. You should see an undistorted version of the camera view
appear in the right side of the window, with all four corner targets visible, as shown below:

Marking the Targets
On this page you ‘tag’ each of the targets by double-clicking in the center of each one in order.
You can pan and zoom around the image using the same controls as the LightBurn edit and
preview windows. When you double-click, a red ‘+’ mark will appear. Place a marker in the center
of each of the four targets, in the order they are numbered (1, 2, 3, 4). If you place one
incorrectly, you can double click near it to shift it around, or click “Undo Last” to remove it and try
again.

Place each marker as accurately as you can. You can see the ideal placement here:

When you have placed all four markers in sequence, zoom back out and verify that all four are
visible and clearly centered on the targets, like this:

Click Next to finish the marker placement screen and click Finish to complete the process and
store the results. You’re done!
Now that everything is aligned, open the Camera Control window again, and simply click “Update
Overlay” to capture and project whatever happens to be in the camera view onto your workspace,
as shown:

Click the “Fade” button to dim the background image, or the “Show” button to toggle it off and
on.

Device Settings
After initial setup, you can access device settings under the Edit > Device Settings menu.

Device Settings Window

Working Size
This is the working size of your laser bed. Set this to the maximum X and Y travel for your laser.
Note that this setting does not affect the laser itself, it’s just to tell LightBurn how large the work
area of the laser is.

Origin
This is the origin corner or 0,0 location for your laser. If you have a GCode based system, this is
almost always at the front left, regardless of the location of your limit switches.
If you have a DSP laser, like Ruida or Trocen, the origin is usually where the limit switches are
placed, and will will be the corner the laser seeks when powered up.
If your laser output is mirrored horizontally or vertically, move the dot to the opposite corner,
horizontally or vertically, depending on the direction that the output is mirrored, and that will
correct it.

Laser Offset
If your laser has a red-dot pointer that is not aligned with your beam, you can enable the Laser
Offset value to compensate for this when framing and positioning.

Scanning Offset Adjust
Scanning offset is useful when doing raster or vector scanning at high enough speeds that delays
in your power supply cause the firing point to be a little behind where it should be. See the help
for Scanning Offset Adjustment here.

O TH ER OP TION S
Note that this section will appear differently depending on the type of controller you have, and not
all settings will appear for all controllers.

Fast Whitespace Scan
When engraving an image, LightBurn normally moves at the same speed across the entire image.
If you are engraving slowly to get a good burn, but the image contains a lot of empty space (white
space), this takes a long time. With the Fast Whitespace switch enabled, LightBurn will boost the
speed through blank areas to the speed you indicate, if it is faster than the current engraving
speed. This can save significant time.
A note for Marlin users: Since Marlin treats G0 and G1 moves identically, this value is used to
specify the speed for rapid moves. If you do not set this value, LightBurn will use the same speed
as the G1 moves.

Enable $J Jogging
On newer versions of GRBL (1.1 and later) $J is a custom jogging mode that has several benefits
over normal jogging, which just sends simple G0 or G1 moves. The new jog format does not affect
the GCode parser state, and if soft limits are enabled, any jog command that would go out of
bounds is simply ignored, without trigging an error or alarm.
This setting also allows cancelling a jog move, which LightBurn uses for Continuous Jog - You press
and hold a move arrow to begin jogging in a direction, then release the button to stop (cancel) the
jog move. Continuous Jogging is enabled in the Move Window. The switch to enable Continuous
Jogging will not appear unless $J jogging is enabled.

Enable DTR signal
Standard serial ports have a pin (Data Terminal Ready, or DTR) that the host enables to tell
modems that software is ready to receive data, and some devices require this signal to begin
communication. Many programmable hobby-level controllers, like Arduino based systems, use the
DTR pin to reset the controller. LightBurn usually sets this value for you, but if you find your
GCode controller won’t communicate, toggling this setting might help.

Use G0 moves for overscan
By default, all scanning moves emitted by LightBurn are G1 moves, where only the power value is
varied, for consistent speed and power output. Some controllers, like FabCreator Smoothieware
boards, have a non-zero power value for their minimum output, and can end up burning during
the overscan portion of an engraving. Turn on this setting to use G0 moves for overscan to
eliminate this.

Enable laser fire button
Diode lasers often don’t have a red-dot pointer like CO2 lasers do, so it is often useful to enable
them at low power for focusing or framing. (Please do NOT do this if you have a CO2 laser, as the
beam is invisible and this could blind you or start a fire). Turning on this setting will enable a
button and a power setting on the Move Window that allows you to turn on the laser at low power
for focusing and positioning.

Enable Out of Bounds warning
DSP controllers automatically check for out-of-bounds conditions, but GCode controllers do not
have advance knowledge of the data being run, and therefore can’t do this. Enabling this flag will
tell LightBurn to warn you if a job will cause your system to travel out of bounds. Note that this
requires your system to have been properly homed, reporting coordinates correctly, and with the
workspace size set properly.

Return to Finish Position
When running jobs in ‘Absolute Coords’ or ‘User Origin’ mode, enabling this flag tells LightBurn to
send the laser to the specified position after a job is run. This is a convenience to move the laser
head out of the way for unloading material.

S-Value Max
GRBL and Smoothieware use the S-Value (spindle speed setting) to control the PWM power output
to the laser. This setting is the number that corresponds to 100% power in LightBurn.
Smoothieware typically uses a value from 0 to 1 and supports fractional numbers in between.
GRBL defaults to 0 to 1000 for newer versions of GRBL, or 0 to 255 for older ones. The S-Value
Max setting in LightBurn must match your controller setting, or you’ll either get not enough power

output (if LightBurn’s setting is lower) or very small power numbers will set your laser to full
power (if LightBurn’s setting is higher). The corresponding setting in GRBL is $30 for the firmware
versions that support it.

Baud rate
Not all controllers communicate at the same rate. The default in LightBurn for GRBL controllers is
115,200 baud (bits per second), and for Marlin it’s 250,000 baud. Some Marlin controllers use
115,200, and some GRBL controllers go as low as 9600. If you are having difficulty getting your
controller to communicate, and you’re sure the firmware is supported, contact the manufacturer
to see if they can tell you the correct baud rate for the board - it might be different than the
default.

Z Axis Controls
Enable Z Axis: turn this on to allow LightBurn to control the Z axis of your machine, IE the height
of the laser above the workpiece.
Note: enabling Z control means that LightBurn will always emit Z values for a running job, and
therefore requires that you set either the “Relative Z moves only” toggle below, or a material
height value on the main cut panel. If you to not set relative mode, and do not set a material
height, the default of 0 may cause LightBurn to raise your bed to a point where the workpiece
could contact the head of your laser.
Reverse Z Direction: Most DSP systems have 0 as the highest point, with positive numbers
moving the laser head further from the bed, however some systems reverse this. Toggle this
switch to change the overall direction for Z moves.
Relative Z moves only: This setting tells LightBurn to read the height of the machine when the
job starts, and uses that height as the starting point for all Z moves, ignoring any specified
material height. This is the simplest way to work, as you just set your focus manually, and
LightBurn will perform all moves relative to whatever height your machine is at when the job
starts. Note: for DSP systems this requires that you are connected to the machine.
Optimize Z Moves: By default, LightBurn will always retract the Z back to the initial height (the
material height) after completing a shape with a Z offset. This is done for safety. Enabling
‘Optimize Z Moves’ will prevent this constant retract / plunge behavior, only issuing Z moves
when the Z changes. If you know your material is flat, and none of the Z moves will position the
laser low enough to run into anything on your work table, this can save a lot of time.

Additional Settings
The Additional Settings page contains settings used by the preview simulation engine to calculate
acceleration timing, traversal speeds, and enforce speed limits when computing the time it will
take to complete a job, and when simulating the job. These must currently be set manually by the
user to match your controller settings, though our goal is to handle this automatically if possible.

Connecting to the Laser
Once you have added your laser to LightBurn, it should appear in the list of devices to the right of
the ‘Devices’ button in the Laser Window. If you only have a single laser, it will be automatically
chosen for you.
If you have more than one laser set up, you might need to select the one to connect to by clicking
here:

Depending on the type of controller you have, you might have to manually choose the port that
the laser is connected to, by clicking where you see ‘(Choose)’ in the Laser Window:

As long as your laser is connected to the same communication port, LightBurn will reconnect
when you re-start. If you reboot your computer, or plug the controller into a different USB port,
you might need to re-select it.
If you see the ‘(Choose)’ as shown above, you need to select the port. If no ports are listed in the
drop-down, it means that no devices were found, which could mean that it is not plugged in
correctly, isn’t powered, or you’re missing a driver.
If your laser disconnects for some reason, or enters an alarm state and needs to be reset, you can
quickly re-connect by right-clicking the ‘Devices’ button in the Laser Window.
Next: Configuring a laser for use with LightBurn

# Move Window
The Move window is used primarily for jogging and positioning, as well as homing functions.

Move Tool Window
Get Position, when pressed, will query the controller for its current location, and display it in the
X,Y,Z,U fields to the right.
The Go button on the right side will send the laser to the entered coordinates in the Move to
Position entry boxes.
The Saved Positions drop-down displays a list of previously stored positions. This can be useful
for jogging to known locations on the work area, like a specific corner, the location of your rotary
tool, commonly used jigs, and so on. You can manage the contents of this list by clicking the
Manage button on the right.
To jog your laser, click one of the arrow buttons around the home button. This will move your head
by the set distance, and speed entered in the window.
The Speed setting in this window also controls the movement speed used when use the Frame
buttons, or using the ‘Click to Move’ tool.
If your laser supports it, enabling the ‘Continuous Jog’ switch changes the behavior - In this mode,
press and hold one of the buttons to move the laser at the desired speed, then release the button
to stop.
You can also get the current position, set or clear a custom origin or set the ‘Finish Position’ - IE,
where the laser head is sent when a job finishes.

Note: If you have a Ruida controller, you will not see Set Origin, Clear Origin, or Set Finish
Position, as these are handled by the controller itself. LightBurn will generally show only controls
you can use.

# Shape Properties
In the Window menu, you can enable the Shape Properties panel, which will contextually display
properties of any selected shape. The contents of this panel will depend entirely on the shape or
shapes that are currently selected.
At the simplest, such as when only a Path shape, QR Code or when multiple shapes are selected,
the panel will only display 3 properties:

Cut Order Priority: Sets the priority of this shape when used with ‘Order by Priority’the Cut
Optimization settings. Lower values are cut first.
Power Scale: Scales the power used to cut this shape by thisbetween Min Power and Max Power
Locked: Prevents movement or other changes to this shape.
Note that locked shapes are shown without the usual selection controls since they cannot be
moved while locked:

Selection Locked
When multiple shapes are selected, changing these values acts on all selected shapes at once.
Other shape types include a wide variety of other properties that can be set but will always also
include the properties listed above.

I MA G E

Gamma: Adjusts the mid-tone curve for images. 1.0 is normal. Lower values brightnen the mid
tones, and higher values will darken them.
Contrast: Increases or decreases image contrast.
Brightness: Increases or decreases image brightness.
Enhance Radius: Radius of edge enhancement - 0 is none.
Enhance Amount: Increases or decreases edge enhancement.
Enhance denoise: Use to reduce noise in smooth areas.
Note: Enhance is also often referred to as “Unsharp masking”, and will increase the contrast of
edges in the image. A larger radius spreads the effect across a wider area near the edge being
enhanced.

E L L IP S E

Width: X axis size component.
Height: Y axis size component.

P OLYG ON

Width: X axis size component.
Height: Y axis size component.
Sides: Number of sides.

R EC TA N G L E

Width: X axis size component.
Height: Y axis size component.
Corner Radius: Sets the radius for curved corners on the rectangle.

T EX T

Max Width: Text will begin scaling if the length exceeds this, use zero for no limit..

# File List Window
This window is only support on DSP controllers that allow hosting files on the controller, and
allows you se see and manage the files hosted there, if the controller supports this.

FileListWindow
Hit the Refresh button to query your controller for the list of hosted files. You can select a file and
press Start to run it, Delete to remove it from the controller, or Download to save it locally.
Pressing Upload will let you choose a local cut file to send to the controller (this is not the same as
the current job, which you can upload with the “Send” button in the Laser window.
It is worth noting that some controllers, particularly Ruida, can take significant time to delete a file
from the beginning of the list if there are many files (or large files) following it. We suspect that
the controller is compacting the internal storage when you do this, so if you are planning to delete
multiple files, it is faster to delete from the end of the list first.
The ‘Delete All Files’ button is generally much faster than deleting files one by one.
The ‘Calc Time’ button is available only on supported controllers (Ruida) and will compute the
time taken to run the job on the controller itself. With engraving jobs this can take a considerable
amount of time to do, as the controller is basically simulating the job internally, and the math is
complex. When it completes, the duration to run the file will be shown in the ‘Info’ column.

# Console Window
On GCode machines, the console window allows you to directly input commands and see
messages from the controller itself.

Console Tool Window
You can type a command in the text box and the console will output the results. Examples would
be manual G-Code commands or retrieving configuration details from your connected device.
If the controller encounters an error during execution, it will be shown here as well.
If you have commands that you use frequently, you can store them in one of the macro buttons.
Right-click a button to bring up the options to change the macro contents. Give the button a
meaningful name, and enter one or more commands to send to the controller when the macro
button is clicked.
Enable the ‘Show All’ toggle switch to display all commands sent between LightBurn and your
controller.
Note, the console window functions are not available on DSP controllers, like Ruida, Trocen, or
TopWisdom as these are not GCode based, and do not accept GCode commands.

Art Library
The Art Library is a way to quickly store and recall artwork that you use on a regular basis and
want quick access to when designing.

On the left side of the window it shows the libraries that are currently loaded, and the right side
shows the artwork in the currently selected library. Artwork can be easily imported into the library
from files on your hard drive, or from a selection in your current project. When you want to use
something from the library, just grab the thumbnail from the right view and drag it into your
project.
Note: The library only stores artwork, much like the contents of your AI, SVG, DXF, or image files.
It does not store the cut or fill settings applied to the artwork.

Library Files
Each library you create is a file on your hard drive containing all the graphics inside it in a
compact form. You can copy library files between computers to share the contents. LightBurn
remembers which libraries you have loaded. Unloading a library file just removes it from your list
of loaded libraries, but doesn’t delete the file or its contents, which makes it easy to bring in
seasonal or holiday specific libraries when you need them, then unload them to reduce clutter
when you don’t.

To create a new (empty) library, click the ‘New’ button and choose a location and a name to store
the library file. Once created and selected, you can immediately start adding content to it.

Adding artwork to a Library
If you have files on your hard drive that you want to add you can click the Import button. This will
let you import multiple files at once if you want to, and each one will become an entry in the
current library. You can also select something in your current project and click ‘Import Graphic
from Project’ to add the selected artwork to the current library.
You can also right-click in the library view, like this:

From the pop-up menu, you can add the current selection to the library, rename the selected
library graphic, or delete it.

Adding artwork from the Library to your project
When you want to use an item from the library, locate it in the thumbnail view on the right, then
simply drag it into your project wherever you would like it to appear, and drop it. You can also
click ‘Add Graphic to Project’ in the buttons along the bottom.

Loading and Unloading Libraries
If you have libraries that you use rarely, or are seasonal (like Halloween, Christmas, Easter,
Spring, Fall, etc) you can unload them when you are no longer using them by selecting the library
on the left, and clicking the ‘Unload’ button. This just removes it from the view, but does not
delete the file from your hard drive. When you need it again, click the Load button, and locate the
file on your hard drive. It will be added back to the list and usable until you unload it again.

Material Library
LightBurn’s Material Library provides a way to store and organize lots of presets for different
operations on different materials, and have a way to quickly apply them. This is entirely usergenerated - You set up a cut layer however you like and save it to a Library. You set a material
type, thickness (if appropriate), and a short description.

Library_UI.png
Any Library setting can be applied to a cut layer by selecting the library entry and assign it to the
layer. Settings are copied, so if you need to make edits to the setting you won’t hurt the copy in
your library - you can edit those independently.

U N DER S TA N DIN G MATER IA L L IB R A RY
Material Library is a simple yet powerful component of Lightburn intended to assist in the
management of the laser cutting process.
The first time you launch LightBurn, an empty Material Library is automatically set up and ready
for new entries. You can easily add to, edit and manage cut settings in this library. Saved libraries

can be loaded and shared from local or network accessed and even cloud based storage for
convenience. To get started, make sure you can see the Material Library window.
In the top menu, select “Window” to ensure that “Library” is checked on. If not, select it to turn
the window on. This will display the Material Library window in the lower-right of the display next
to a box called “Laser”.

C R EATE N EW FR OM L AYER
LightBurn makes it easy to build out your library using the current cut settings assigned to any cut
layer.
Select one of your cut layers then click the Create new from layer button in the “Library”
window.

Library_new_Layer.png
Fill out the details sheet providing a Name, Thickness (if appropriate) and a short
Description of the cut layer parameters. Once completed, click the Ok button to save this
new entry into your library.

Library_new_Layer_details.png
Now you can use this new entry titled “Birch Ply” anytime in the future and easily assign it
to a new cut layer.

Library_new_Layer_result.png

There are several helpful ways to facilitate adding to and managing your library covered later in
the “Manage existing Library” section below.

S AV E A L IB R A RY
As you fill out the Library with your favorite materials, it is always a good idea to periodically save
your additions. To do this, click the Save button.

Library_Save.png

A SS IG N L IB R A RY S ET TIN G S TO L AYER
Now that you have some entries added to your library, you can use them to quickly and easily
apply these settings to your work. Settings are copied, so if you need to make edits to the setting
you have applied you won’t hurt the originals in your library.

Library_Assign.png

N EW L IB R A RY
Depending on your workflow, you may find it desirable to have several libraries to work from. You
can start a new Material Library anytime by clicking the New button at the lower-right corner of
the “Library” window. Now you are presented with a new, blank library ready to fill out and save.

Library_New.png

LOA D A L IB R A RY
Selecting Load provides access to your previously saved Libraries. Once clicked, a file finding
window will open allowing you to point to a saved library. Select library of choice and click the
Open button. Your chosen file will then become the active library for use.

Library_Load.png

M A N A G E EX IS TIN G L IB R A RY
Existing Library entries can be managed in several helpful ways. Changing existing cut settings
and discriptions, quickly duplicating entries, removing unwanted entries or producing copies of
the entire library can be done in a snap.
Note: These items are only selectable when “Description” is selected.

Library_Edit.png

Edit Cut
Click Edit Cut to open the “Cut Settings Editor”. This allows you to change any of the cut settings
as you would normally and saves them back to the library.

Edit Description
Click Edit Description to modify the Name, Thickness and Description for the highlighted entry.

Duplicate
Click Duplicate to create a copy of the highlighted entry. This can be helpful in quickly adding to
your library.
Hint: Combined with Edit Description and Edit Cut you can keep the same “Material Name” and
“Thickness” to create ‘nested’ entries (e.g. 3mm cut, scan and image). Keeping just the “Name”
while changing the “Thickness” allows nesting of different thicknesses of the same material.

Delete
Click Delete to remove a single cut setting entry from the library.

Save As
Click Save As to create a complete copy of your active library and saves it under a new name of
your choice.

A DVA N C ED U S A G E
Multiple machines/users access to shared Library
Multiple machines can access a single Material Library file hosted on a network drive or from
cloud service storage (e.g. Dropbox, Google Drive, iCloud, OneDrive, etc.).
Create a library on one machine and save it to your network or Google drive, DropBox, etc..
Point to that saved library file after hitting ‘Load’ in the ‘Library’ screen of LB for each
machine.
If you edit that library the changes will be there of both machines as they are pointing to
the same file.

Settings
The Settings window in LightBurn controls global user preferences for LightBurn. There are quite a
few settings, so we’ve split it into two pages - Display / Units settings and File settings - though
this breakdown was somewhat arbitrary.

Display & Units Settings
The first page is the display and units settings, shown below:

In here there are a few groups of settings that control different parts of LightBurn.
Display / Graphics
In here are things that control the overall display and presentation of LightBurn.

Beginner Mode

If you are new to LightBurn, enabling Beginner Mode can help you learn your way around
LightBurn by removing options that are commonly misunderstood, used by accident, or just used
rarely by new users. This reduces the complexity of the UI somewhat, particularly in the cut
settings, but be aware that the options you see in the interface will look different than those in
video tutorials or screen shots in the documentation.
If you are searching for a button or feature and it doesn’t appear where it should, it could be
because you have Beginner Mode enabled, but it could also be because your laser simply doesn’t
support that feature - LightBurn’s interface adapts and shows only those features supported by
your hardware.
Curve Quality

This controls the level of precision that LightBurn outputs splines. If you look closely at the
comparison below, you can see the right image is made of straight lines, about 1/8" (4mm) long.
The left image is also made of line segments, just many more of them, so the effect is
imperceptible. This extra quality comes with a slight cost in speed. You’ll only likely notice it in
files with thousands of curved shapes.

Curves-High-vs-Low
Enable Anti-aliasing

Aliasing is commonly called “jaggies” - in our case, it’s the visible appearance of pixels when
drawing 2d shapes. Anti-aliasing draws shaded pixels on either side of the drawn lines to give the
appearance of higher resolution and a smoother result. The image below compares the two - The
difference is very apparent, however this comes with a moderate performance penalty. If you are
running an older machine, turning off antialiasing may improve the interactivity of LightBurn on
dense scenes.

Antialiasing-vs-Normal
Filled Rendering

When enabled, will display filled shapes directly in the edit window. This takes longer than
rendering the wire outlines, and it can hide things from you behind those filled shapes that may
still be sent to the laser, so we recommend using this only for spot-checking your work, and not
for general editing.
Use Dark Background

Shows the main edit window using a dark color scheme which may be easier on people with light
sensitivity.
Show Palette Button Labels

This setting, enabled by default, shows numbered labels on the color palette swatches, making it
easier to tell the more similar entries apart. This is also useful for users with color blindness or
other vision impairments.
Use System Clipboard

Enabling this makes copy and paste operations slightly slower, but allows LightBurn to:
Copy and paste across different runs of LightBurn, or between two running copies of the app
Paste images copied from other software or web browsers
Paste text directly into the edit window, auto-creating a text object for you
Invert mouse wheel zoom direction

I’m a PC user, with a Mac, and the scroll wheel always feels backwards to me, so this switch
changes the direction you scroll when zooming. If you’re a Mac person stuck on a PC, this is also
for you.
Show full-screen line cursor

When enabled, this feature draws a cross-hair that spans the entire edit screen, which can make it
easier to line up graphics.

Units & Grids
Inches / mm

LightBurn internally operates in millimeters, but can display in either millimeters or inches.
Speeds can be represented as either units per second or units per minute. Users with diode lasers
will likely prefer the units per minute setting, whereas CO2 lasers generally express speeds using
units per second.

Visual Grid Spacing

The visual grid is set to 10mm by default. Note that this is independent of the Grid Snap setting
below.
Grid Snap Distance

Positioning of lines and other primitives will snap to the Grid Snap distance unless overridden
using the Ctrl key. The default for this is 1mm.
Click Selection Tolerance

This is how close you have to be to a line or vertex, in screen pixels, to click it. Increase this
number if you have trouble selecting things, decrease it if you find yourself selecting things you
didn’t mean to.
Object Snap Distance

Controls how close, in screen pixels, your cursor has to be to an object vertex or center to engage
the object snapping behavior.
Snap to Objects / Snap to Grid

LightBurn has two snapping behaviors which can be enabled / disabled here. Snap to Objects will
snap your pointer location to the nearest object center or vertex when creating new objects, or
drawing lines, making it easier to connect and align shapes. Snap to Grid will snap your cursor
position to the nearest grid location, as specified by the Grid Snap value. Note that the Grid Snap
and the Visual Grid do not have to be the same.
Shape Move Increments
When moving objects with the cursor keys in the edit window, these values control the distance to
move the selection, when using the arrow keys by themselves or with the Control or Shift
modifiers.

F IL E S ET TIN G S
DXF Import Settings
Units

DXF files do not store the measurement system that was used to create them. If you create an
object that is 5 inches wide, it might import as 5mm wide, because LightBurn can only see the ‘5’.
Similarly, if your object was created in microns, it might import huge. Set this value as
appropriate before importing DXF files to ensure correct scaling.
Auto Close Tolerance

DXF files are often saved as a collection of discrete pieces, instead of continuous paths. The AutoClose Tolerance value tells LightBurn to connect any lines or curves that are on the same layer
and closer together than this value.

Other Settings
Auto Save Interval

You can set the frequency of your auto-save by adjusting the value in minutes here. Setting the
auto-save interval to 0 disables the automatic backups.
Curve Tolerance

This setting is similar to the Curve Quality setting above, except that it controls the quality of
output to the laser. The number is a measure of how much error to allow in the output. A value of
0 would be “perfect”, but would create very dense data, as some lasers can only process line
segments.

OutputTolerance
In the above image, the blue curve between the two points is the ideal shape. The black line is a
straight line between them, and the red line shows the error (how far the line is from the curve).
LightBurn measures this error, and if it’s equal to or lower than the Curve Tolerance value, it
outputs the straight line. If not, the curve is subdivided into two linear segments and the process
repeats with each new segment. Those segments are shown below in violet, along with their new
error values. You can see that the two new lines do a much better job of approximating the
original curve.

OutputTolerance-SubDiv
Most people will probably never need to change this - the default is 0.05mm, which is about 1/2
the width of a typical beam. Note that this is the maximum error value allowed, so typical output
will be better than this, and this only affects curves, not straight lines or vertices, which are exact.

Return to main page

Rotary Setup
This will walk you through setting up and using your rotary attachment with LightBurn.
In the top menu bar, click the Tools menu, then Rotary Setup (near the bottom) and it will open
the rotary setup window, shown here:

Rotary Setup Window
The window may look different depending on the type of controller you have, and in fact, you may
not be able to access this menu item at all - most Trocen controllers, for example, require setting
rotary parameters through a menu on the controller panel itself.

General rotary setup
If using a Ruida controller, disconnect the Y axis stepper connection and connect the rotary
attachment to the Y axis. If using Smoothie or Grbl, C3D, or Smoothieware controllers, click the
“A” axis selection. (See below on how to configure your controller steps before you proceed).
Choose whether you have a chuck style or roller attachment.
Click the enable rotary check box (it will turn green when enabled).
In the steps per revolution box, enter the number of steps it takes your attachment to make one
full revolution. For a chuck rotary, this will be one rotation of the chuck, and for a roller, it will be
one full rotation of the roller, NOT the item. For GCode devices with a dedicated rotary axis, this
number should just be “360 degrees”. If not using a dedicated rotary axis, you’ll have to use trial
and error to dial in the correct travel distance using the Test button.

Click the Test button to verify that the roller or chuck makes one full rotation, pauses, then
returns.
Enter either the diameter of the object to be engraved or it’s circumference, the other value will
be automatically calculated.
Note: If you are using a DSP controller (Ruida, etc), when you change the rotary setting you need
to power-cycle the controller, as some of the internal logic isn’t adjusted for the rotary setting
unless you do this. Change the setting, close the Rotary Setup window to write the change to the
controller, then power off the control board and power it back on. You will likely need to press the
Esc (or stop) button on the controller to prevent it from trying to home itself, as the Y axis will not
home properly.
Align your object under the laser head in a position where the X axis will start and rotate the
object in the rotary attachment to the point where you want the Y axis to start engraving.
When using the rotary, it’s generally a good idea to use “current position” as the “Start From”
setting.
Click Start to run your job, or if you have a DSP controller, you can use Send to send it to the
controller to run it from there.
Remember to uncheck the use rotary attachment check box once you are finished so
that you do not mess up your next regular project.

General notes on using a rotary attachment:
If the object slips on the rollers of a roller type attachment, wrap the rollers with some sort of nonslip material or even rubber bands.
You can also try placing some weights inside the object such as ball bearings or other small round
objects, this will help press the object against the rollers.
If you end up with a flat part at the ‘bottom’ of the engraving, it means your rotary gear
mechanism has backlash. In general, tightening any belts in the rotary device will fix this, but if
not, you can place a small line a few mm below the bottom of your design, set to very low power,
like 0.1%, and set it as the first layer to run. The rotary will spin to this position, then back up over
that few mm of gap, and will take up the backlash with that movement.

Notes for C3D, Smoothieware or GRBL users:
Before configuring the above, you will likely need to set up the rotary axis on your controller.
LightBurn sends rotary moves as angle values, and the GCode controller translates those angles
into actual movements. To do this, it needs to know the correct number of motor steps to take for
one degree of movement on the rotary motor.
If you have a Cohesion3D, Smoothieboard, or other common GCode based controller, the number
is usually 200 times your microstepping multiplier (usually 8 or 16) times any gear reduction,
divided by 360.
For a Cohesion3D or HolgaMods rotary, this is usually
3200 steps (200 x 8 micro steps x 2x reduction) / 360 = 8.88888888 steps per degree 6400 steps
(400 x 8 micro steps x 2x reduction) / 360 = 17.7777778 steps per degree
The steps per degree number, along with acceleration and maximum speed will need to be set in
the appropriate location for the controller. With Smoothieware, it would be the ‘delta’ settings in

the config.txt file on the controller. For GRBL, it can be accessed in Edit > Machine Settings in
LightBurn, under vendor settings for the A Axis.

# Tabs / Bridges
Sometimes it is helpful to include tabs (sometimes called bridges) in objects that you are cutting
out so that they do not fall out immediately but can be removed later. The concept comes from
the CNC world but is much simpler in the context of a Laser. Simply put, it’s where you skip a very
small section of a cut, often less than 1mm in length. In the example below, the left square has no
tabs applied, while the right has a single 1mm wide tab on each side.

Tab Example

B A S IC U S A G E
First, note that you will need to disable Beginner Mode in the LightBurn Settings otherwise the
tabs functionality will not be available. Once that is done, you will see the “Add Tabs” tool is
available:

Add Tabs Tool
You can only add tabs to shapes that are in Line mode. Once the Add Tabs tool is selected you
will see the Insert Tab cursor (

) when hovering over a shape which you can add a tab to.

Simply click where you would like a tab, and a red circle will apear where you clicked, denoting
that a tab will be placed there.

Inserted Tab
Tabs default to 0.5mm in width and you can place many tabs on any shape. The system will,
however, limit how close any two tabs can be based on the currently set tab size.
If a tab needs to be moved, simply click on it again and drag it to a new location, even on another
shape.
Finally, you can delete a tab by double-clicking or shift+clicking the tab.

A DVA N C ED U S A G E
In a Line mode cut setting’s option dialog you will now see a Tabs / Bridges section which allows
more control.

Tab Settings
Global Enable / Disable

The Tabs / Bridges group has a checkbox in the top-left. Flipping this to off will supress any tabs
on that cut layer without losing any previously configured tabs or tab settings.
Tab Generation

Manual - Any tabs must be manually placed using the methods described above.
Automatic - Tabs will be placed on all cut layer shapes, based on the values of Even Spacing,
Tabs Per Shape, and Skip Inner Shapes.
Tab Size

Defines the total length of any tabs in whatever the currently configured system unit type is (mm
or inch). The system will skip cutting for this distance, if possible.

Even Spacing

When automatically generating tabs, each contiguous path section will have at least one tab
applied at the very start of the path and then again at this distance interval (mm or inch
depending on unit settings).
Tabs Per Shape

When automatically generating tabs, using this option will place this number of evenly spaced
tabs on each contigious path section for each shape on the cut layer.
Tab Cut Power

If set to anything other than 0% tabs will have pulsed cuts across the distance of the tab instead
of just skipping it completely. In the example below, the top tab is set to 25% whereas the bottom
tab is set to 75%.

Tab Pulse
Not all laser controllers can reliably vary the power mid-cut so this was a way to implement
“partially cut” tabs in a consistent way. By increasing the amount it pulses on during the tab you
can further weaken the tab overall.
Skip Inner Shapes

When enabled any shapes that are completely contained by another shape in the same cut layer
will not have automatic tabs applied. This does not effect manual tab placement.
Clear Tabs

Delete all tabs (manual or automatic) from every shape on this cut layer.

# Measure Tool
With the measurement tool you can view a wide array of useful information about any shape
object. To use this tool, click on the icon in the Creation Tools toolbar.

It will display the following dialog:

As you hover the curor over shapes, it will highlight any indiviual shape in green and the line or
curve segment the cursor is currently over in purple, as you can see below:

The values show in the measurement dialog are as follows:
Nodes: Number of vertices (beginning or ending points of line/curve segments) in the shape.
Lines: Number of straight lines in the shape.
Curves: Number of arcs or bezier curves in the shape.
Perimeter Length: Total length of all line/curve segments in the shape.
Closed/Open: Whether or not the shape is closed. Defined as all line/curve segments beginning
and ending on nodes shared with another line/curve segment.
Area: The total area of the shape. Value is empty if shape is not closed.
Segment Length: Length of the line/curve segment currently highlighted in purple.
Start Point: X,Y coordinate of the start node of the currently highlighted line/curve segment.
End Point: X,Y coordinate of the end node of the currently highlighted line/curve segment.
Difference: End Point values minus the Start Point Values
Angle: Angle of the line between the start and end points. In the case of regular line segments
this is the angle of the line itself.
Arc Radius: For curves that are perfect circular arcs and not complex bezier curves, this is the
radius of that arc. Value is empty otherwise.
Arc Center: For curves that are perfect circular arcs and not complex bezier curves, this is the
center point of that arc. Value is empty otherwise.
Below you can see further examples of the state of the measurement tool dialog, based on the
type of segment being measured.

D R A G MEA S U R E
If you need to measure the distance between two shapes you can click and drag between and two
anchor points and get the above information but pertaining to the two nodes.

# Variable Text Formats
These are the different formatting codes used for Variable Text in LightBurn.

D ATE / TIME TEX T FOR MAT
When using the Date/Time mode for text, the system will automatically substitute special
combinations of characters with values for the current local date and time.
For example, if your text field is “d/MM/yyyy” the system would replace it with “15/6/2019”. The
values you can use for substitution are listed below.
These expressions may be used for the date:
Output

Expression

the day as number without a leading zero (1 to 31)

d

the day as number with a leading zero (01 to 31)

dd

the abbreviated localized day name (e.g. ‘Mon’ to ‘Sun’). Uses the system locale
to localize the name.

ddd

the long localized day name (e.g. ‘Monday’ to ‘Sunday’). Uses the system locale to
dddd
localize the name.
the month as number without a leading zero (1-12)

M

the month as number with a leading zero (01-12)

MM

the abbreviated localized month name (e.g. ‘Jan’ to ‘Dec’). Uses the system locale
MMM
to localize the name.
the long localized month name (e.g. ‘January’ to ‘December’). Uses the system
locale to localize the name.

MMMM

the year as two digit number (00-99)

yy

the year as four digit number

yyyy

These expressions may be used for the time:
Expression Output
h

the hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display)

hh

the hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display)

H

the hour without a leading zero (0 to 23, even with AM/PM display)

HH

the hour with a leading zero (00 to 23, even with AM/PM display)

m

the minute without a leading zero (0 to 59)

mm

the minute with a leading zero (00 to 59)

s

the whole second without a leading zero (0 to 59)

ss

the whole second with a leading zero where applicable (00 to 59)

z

the fractional part of the second, to go after a decimal point, without trailing
zeroes (0 to 999). Thus “s.z” reports the seconds to full available (millisecond)
precision without trailing zeroes.

zzz

the fractional part of the second, to millisecond precision, including trailing zeroes
where applicable (000 to 999).

Expression Output
AP or A

use AM/PM display. A/AP will be replaced by either “AM” or “PM”.

ap or a

use am/pm display. a/ap will be replaced by either “am” or “pm”.

t

the time zone (for example “CEST”)

Any sequence of characters enclosed in single quotes will be included verbatim in the output
string (stripped of the quotes), even if it contains formatting characters. Two consecutive single
quotes (’’) are replaced by a single quote in the output. All other characters in the input string are
included verbatim in the output string.
Formats without separators (e.g. “ddMM”) are supported but must be used with care, as the
resulting strings aren’t always reliably readable (e.g. if “dM” produces “212” it could mean either
the 2nd of December or the 21st of February).
Example format strings (for the date & time 21 May 2001 14:13:09.120):
Input

Result

dd.MM.yyyy

21.05.2001

ddd MMMM d yy Tue May 21 01
hh:mm:ss.zzz

14:13:09.120

hh:mm:ss.z

14:13:09.12

h

M

M

M

M
2 : 13
M : 9 pm

S ER IA L N U MB ER TEX T FOR MAT
When using the Serial mode for text, the system will automatically substitute certain special
combinations of characters with the current serial number value, and other characters control
how it is formatted.
These expressions may be used for serial numbers:
Output

Expression

The serial number as a decimal value

d

The serial number as a hexadecimal value, lower case h
The serial number as a hexadecimal value, upper case H
Tells LightBurn to pad the number with leading zeros

0

The number of characters used controls how many digits the system will display. If the serial
number is larger than the number of digits allowed, as many digits as will fit from the end of the
number will be displayed. For example, if your serial number is 1234, the table below shows how
that number would be formatted for each of the displayed formatting inputs:
Input

Output Input

Output

d

4

0d

4

dd

34

0dd

34

ddd

234

0ddd

234

dddd

1234

0dddd

1234

ddddd 1234

0ddddd 01234

Input

Output Input

dddddd 1234

Output

0dddddd 001234

You cannot mix decimal and hexadecimal formatting in the same text entry, and you cannot split
a serial number with other characters. For example, this string is not valid: ddd-ddd because of
the hyphen between the two groups of format characters.
Like the Date / Time formatting, any text between a pair of single quotes is copied exactly to the
output, and a pair of single quotes together is replaced by one single quote in the output.

C S V / MER G E TEX T FOR MAT
When using the CSV/Merge mode for text, the system will automatically substitute certain special
combinations of characters with entries from the selected row of a CSV file. A CSV file is “Comma
Separated Values” - a very simple text format that uses a line in the file as the row, and commas
to separate columns in the file.
For example:
LightBurn,80,10
Corel,300,20
In a CSV/Merge entry in LightBurn, the text you enter uses the percent sign followed by a number
to look up a column in the current row of the CSV file. For example, using this text with the above
table:
M

M

M

M

M

M

M

M

M

M

M

M

Would display:
M

M

n - it costs $80

Columns are numbered starting from 0.

C U T S ET TIN G TEX T FOR MAT
When using the Cut Setting mode for text, the system will automatically substitute certain
characters with values from the cut setting applied to the text.
Like the Date / Time or Serial number formatting, any text between a pair of single quotes is
copied exactly to the output, and a pair of single quotes together is replaced by one single quote
in the output.
Expression Output
C

followed by a number, pulls settings from the numbered cut layer (ex, C03) for the
remainder of this string

s

speed, as a number in the current speed units

S

speed, including the current units (like mm/sec)

p

max power, as a percentage

Expression Output
P

max power, including the percent sign

m

min power, as a percentage

M

min power, including the percent sign

d

DPI, as a number, always dots per inch

i

interval, in the current distance units

I

interval, including the current distance units (like mm)

L

Displays the name of the laser. Can optionally be followed by a character index to
start displaying from, and optionally, a comma and a 2nd number for the number
of characters to display. For example, if L displayed ‘Ruida 6442G’, L6 would
display ‘6442G’, and L6,4 would display ‘6442’ (without the quotes)

z

Z offset for the current layer, in the current distance units

Z

Z offset for the current layer including the units (eg, mm)

# QR Code Generation
QR Codes are square 2D barcodes that can be scanned by a mobile device with a camera. They
are able to store and convey a wide variety of information, such as simple text, a URL, or even
WiFi access information, such as the example shown below.

Example QR Code
Most modern mobile devices with a camera include some sort of built in QR code scanning ability,
often direct from the stock camera application. Simply point the camera at the code and it will
recognize it and provide a prompt to proceed with whatever information is contained. If this does
not work, check the documentation for your specific device. In some cases, you may need to
download a barcode scanning application.

USAGE
LightBurn can easily generate QR Codes for you using the QR Code tool. Navigate to the Tools
Menu and then select Create QR Code as shown below.

QR Code Menu
With the QR tool selected, click and drag in the Edit Window where it will show a square being
drawn, this will be the initial size of your QR Code. Once you release the mouse button, you will
be shown the QR Code Properties dialog.

QR Code Dialog
From here there are 3 main options for QR code content:
Raw content: typically plain text or URLs
WIFI: Creates a WiFi access point configuration code for mobile devices.
Contact: Creates a “Contact Card” code which will load contact info into your mobile device’s
contacts.
As you enter QR Code content you will see the QR code in the edit window update in realtime. The
more content you add, the smaller the sub-squares will become to fit all of that data. You can
always scale the size of the QR Code after the fact, if needed.
Note that you may also edit an existing QR code object by selecting it, right clicking, and choosing
the Edit QR Code option. This will bring up the same QR Code Properties dialog as before with all
the information filled in.

Edit QR Menu

Raw Content
This is the simplest and most flexible option as it allows you to enter any text you would like. At
the simplest this is just basic plain text or a URL. But there are a wide variety of other options
supported by many mobile devices such as email addresses, phone numbers, geo-location
information, and more. There is a great list explaining the options and how the text must be
formated on the zxing barcode scanner documentation.

Raw Example

WiFi
With with WIFI tab you can create a barcode that, when scanned, will allow that mobile device to
automatically contect to a WiFi access point with all of the connection informtation provided.

WiFi Example
The input options are:
Network name / SSID: The configured name of the access point
Password: The WEP or PSK password for the network if one is required (see Authentication type
below)
Hidden network: When checked this specifies that the SSID of the network to connect to is not
broadcast publicly and that the mobile device should act accordingly.
Authentication type: Choose from WPA/WPA2, WEP, or None. Typically most modern access points
use WPA2. Check the configuration on your access point if you are unsure.
Once you’ve entered the WiFi access point information the content under the Raw Content tab will
automatically be updated to reflect the WiFi configuration. As shown below:

WiFi Example
The WiFi raw content format is described in more detail in the zxing barcode documentation.

Contact
With the Contact tab you can create barcodes that contain contact information which can then be
automatically loaded into a mobile device’s contacts storage.

WiFi Example
Just like with the WiFi tab, once infomation is entered on the Contacts tab, if you go back to the
Raw Content tab you will see the raw contact card shown, which in this case is in the “MECARD”
format.

WiFi Raw

C U T S ET TIN G S
Because of the way QR Codes work it’s assumed that there is a high amount of contrast between
the light and dark sections of the barcode. Most importantly the dark sections must be completely
filled so you should be sure to use the “Fill” mode on the cut layer being used for the QR Code. If
in LightBurn you see the QR Code render as shown below, that means you either are not using
“Fill” mode on that cut layer or filled rendering is turned off.

Unfilled
You can enable filled rendering from the Window menu by choose Filled / Coarse or Filled / Smooth

Fill Render Menu
If you would rather not enable filled rendering in the edit window, you can also see a preview of
what the filled QR code will look like by launching the cut Preview. You will, of course, still need to
have the QR code on a “Fill” mode cut layer.

Unfilled
Once in “Fill” mode, be sure to set an appropriate power level for the material you are using in
order to provide sufficient contrast between the fill engraved areas and the base material similar
to what you see below:

